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Overview
Welcome to the Shape Sculptor User's Guide!
This guide is intended for users who need to become quickly familiar with the product.
 
This overview provides the following information: 

●     Shape Sculptor in a Nutshell 

●     Before Reading this Guide 

●     Getting the Most Out of this Guide 

●     Accessing Sample Documents 

●     Conventions Used in this Guide 

Shape Sculptor in a Nutshell 
Shape Sculptor Version 5 application is a new powerful product enabling users to quickly create, edit, 
modify and sculpt polygonal models. Within Shape Sculptor, a scanned model can be imported and 
quickly edited to add details and new features. Polygonal models can also be created by tessellating 
existing surface models or generated from 3D curves. With its powerful and intuitive polygonal 
modeling tools, new features and details can be added to the polygonal model. 

Thanks to its ease of use, Shape Sculptor is the perfect tool to rapidly edit and sculpt polygonal 
models and complements surface-based conceptual modeling tools when surfacing becomes too 
complex. 

Shape Sculptor can be used with other curve and surface-based modeling tools, including Generative 
Shape Design, FreeStyle and Automotive Class A and also in cooperation with other polygonal 
products including Digitized Shape Editor, STL Rapid Prototyping and Quick Surface Reconstruction.

Before Reading this Guide 
Before reading this guide, you should be familiar with basic Version 5 concepts such as document 
windows, standard and view toolbars. Therefore, we recommend that you read the Infrastructure 
User's Guide that describes generic capabilities common to all Version 5 products. It also describes 
the general layout of V5 and the interoperability between workbenches.

You may also like to read the following complementary product guides:

●     Generative Shape Design,

●     FreeStyle,

●     Automotive Class A,

●     Digitized Shape Editor,

●     Quick Surface Reconstruction

Getting the Most Out of this Guide 



To get the most out of this guide, we suggest that you start reading and performing the step-by-step 
Getting Started tutorial. This tutorial will show you how import and decimate a polymesh.

Once you have finished, you should move on to the User Tasks section, which deals with handling all 
the product functions. 

The Workbench Description section, which describes the Shape Sculptor workbench, and the 
Customizing section, which explains how to set up the options, will also certainly prove useful. 

Navigating in the Split View mode is recommended. This mode offers a framed layout allowing direct 
access from the table of contents to the information.

Accessing Sample Documents 
To perform the scenarios, sample documents are provided all along this documentation. For more 
information on accessing sample documents, refer to Accessing Sample Documents in the 
Infrastructure User's Guide.

http://arbre2dsy/spuCXR15/Doc/online/basug_C2/basugbt0208.htm


Conventions
Certain conventions are used in CATIA, ENOVIA & DELMIA documentation to help you recognize and 
understand important concepts and specifications. 

Graphic Conventions

The three categories of graphic conventions used are as follows:

●     Graphic conventions structuring the tasks

●     Graphic conventions indicating the configuration required

●     Graphic conventions used in the table of contents

Graphic Conventions Structuring the Tasks

Graphic conventions structuring the tasks are denoted as follows:

This icon... Identifies...

estimated time to accomplish a task

a target of a task

the prerequisites

the start of the scenario

a tip

a warning

information

basic concepts

methodology

reference information

information regarding settings, customization, etc.

the end of a task



functionalities that are new or enhanced with this release

allows you to switch back to the full-window viewing mode

Graphic Conventions Indicating the Configuration Required 

Graphic conventions indicating the configuration required are denoted as follows:

This icon... Indicates functions that are... 

specific to the P1 configuration

specific to the P2 configuration

specific to the P3 configuration

Graphic Conventions Used in the Table of Contents

Graphic conventions used in the table of contents are denoted as follows:

This icon... Gives access to...

Site Map

Split View Mode

What's New?

Overview

Getting Started

Basic Tasks

User Tasks or Advanced Tasks

Interoperability

Workbench Description

Customizing

Administration Tasks

Reference



Methodology

Frequently Asked Questions

Glossary

Index

Text Conventions

The following text conventions are used:

●     The titles of CATIA, ENOVIA and DELMIA documents appear in this manner throughout the text.

●     File -> New identifies the commands to be used.

●     Enhancements are identified by a blue-colored background on the text.

How to Use the Mouse

The use of the mouse differs according to the type of action you need to perform.

Use this
mouse button... Whenever you read...

 
●     Select (menus, commands, geometry in graphics area, ...)

●     Click (icons, dialog box buttons, tabs, selection of a location in the document 
window, ...)

●     Double-click

●     Shift-click

●     Ctrl-click

●     Check (check boxes)

●     Drag

●     Drag and drop (icons onto objects, objects onto objects)

●     Drag

●     Move

●     Right-click (to select contextual menu)





What's New?
No enhancement in this release.

 



Getting Started
Before getting into the detailed instructions for using CATIA Shape Sculptor, the following 
tutorial aims at giving you a feel of what you can do with the product. It provides a step-by-
step scenario showing you how to import and decimate a polymesh. 

 The main tasks described in this section are: 

Entering the Workbench
Importing a Polygonal Mesh
Decimating a Polygonal Mesh

 

This tutorial should take about 10 minutes to complete. 



Entering the Workbench

The first task will show you how to enter the Shape Sculptor workbench.

The only pre-requisite for this task is to have a current CATIA V5 session running.

1.  Select Shape Sculptor from the Start -> Shape menu.

The Shape Sculptor workbench is displayed and ready to use.
The workbench looks like this:

 The Part name dialog box may appear depending on the way you customized your session. It provides a 
field for entering the name you wish to assign to the part, an option that enables hybrid design an two other 
options to insert a geometrical set and/or an ordered geometrical set in the part to be created.
For more information, refer to the Part Document chapter in Customizing section of the Part Design 
documentation.



 

You may add the Shape Sculptor workbench to your Favorites, using the Tools -> Customize item. For 
more information, refer to the Infrastructure User's Guide.

If you wish to use the whole screen space for the geometry, remove the specification tree clicking off the 
View -> Specifications Visible menu item or pressing F3.

http://arbre2dsy/spuCXR15/Doc/online/basug_C2/basugcu0100.htm


Importing a Polygonal Mesh

This task shows how to import digit files describing a cloud of points (scanned or computed) 
or a polygon. 

1.  Click the Import icon . 

The Cloud Import dialog box is displayed.

2.  In the Selected File area, use the ... button to browse your directories and select a 

file.

3.  Click Apply and OK to finish the import of the polygonal mesh.



Decimating a Polygonal Mesh

This task shows you how to decimate a polygonal mesh, in order to reduce the triangle count 
of a polygon. 

Open the Bunny1.CATPart document.

1.  Click the Decimation icon  and select a polygonal mesh. 

The Decimate dialog box is displayed:

2.  Check the type of decimation you want to apply: 

❍     Chordal Deviation, or

❍     Edge Length

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/samples/Bunny1.CATPart


3.  Click Apply. 

The decimation is computed. The counts of triangles are updated in the Current 
Triangle Count.

4.  Either press OK to validate the decimation and exit the action;

or press Apply to start continue the decimation with the same values or new ones;

or press Cancel to exit the action and revert to the initial model.



User Tasks
Input / Output

Selecting Components
Creating
Editing

Modeling
Analyzing

Interoperability with Wireframe
Generic Tools



Input / Output
Importing Files

Exporting to STL
 



Importing Files
 

This task shows how to import digit files describing a cloud of points (scanned or computed) or a mesh. 

Use the MultiImport1.cgo_ascii, MultiImport2.cgo_ascii, MultiImport3.cgo_ascii from the samples directory.

Available formats depend on the workbench you are working in.

Files import from ENOVIA is not yet implemented.
 

Digitized Shape Editor 
●     Ascii free,

●     Atos (the quality of the points can be taken into account),

●     Cgo,

●     Gom-3d (as points, scans, grids or meshes, the quality of the points can be taken into account),

●     Hyscan,

●     IGES (IGES Entities 116 are processed. If the cloud to import is made of Entities 116 only, the result is a cloud of points. Otherwise, the 

result is made of scans).

●     Kreon

●     Steinbichler (as points, grids or scans),

●     Stl (bin or ascii, with creation of free edges and facets, if requested).

 
 

STL Rapid Prototyping 
●     STL files (bin or ascii, with creation of free edges and facets, if requested) (default option),

●     Cgo,

●     Ascii free,

●     IGES (IGES Entities 116 are processed. If the cloud to import is made of Entities 116 only, the result is a cloud of points. Otherwise, the 

result is made of scans).

●     In Cgo, Ascii and IGES formats, you can not process more than 10,000 points at each import, in one or several files, e.g. you can not import 
4 files of 3,000 points each in one shot but you can import them separately.

●     This limitation applies to the input files (before Sampling or resizing with the bounding box).

●     If you try to import over 10,000 points in one shot, a fatal error panel is displayed: Too many points for this configuration.
❍     If the Grouped option is active, no file is imported.

❍     If the Grouped option is not active, files are imported as long as the sum of their points does not exceed 10,000 points.

●     Mesh Regeneration is not available on those files.

 

Shape Sculptor
●     STL files (bin or ascii, with creation of free edges and facets, if requested).



 

1.  Click  the Import icon . The Cloud Import dialog box is displayed.

2.  In the Format field, select the file format.

3.  In the Selected File area, use the button ... to browse your directories and select a file.

4.  Check the box Statistics to display information about the model you are importing. If you want to import several files in one shot, 

please refer to the Grouped explanations. 

5.  In the Options field:

●     Enter the Sampling percentage to apply; 

The sampling value determines the percentage of points or scans or grids that will be read from the digit file.

●     Enter the Scale factor to apply to the model, as well as the Unit used in the file.

●     If the extension of the file you have selected is consistent with the list proposed, the Format field is updated automatically. Otherwise, be 
careful to enter the correct format in that field.

●     Once you have performed an import operation, V5 proposes the last entered file path and format as default. If you click on ..., the last 
entered directory is proposed as default.

●     The File unit option is not relevant to the Steinbichler format, nor the Sampling percentage to the Stl format.

6.  For some digit file formats, you may want to enter additional data that are displayed by clicking the button More>>



For Ascii: For Atos and Gom-3d: For Iges: For Stl:

Direction and Delimitors apply to scans. Enter these data whenever you know them.

Minimal Point Quality is used to clean Atos file from invalid points. The quality value of a point lies between 0 and 255 (low to 
high). Choose a value to ignore points below that value:

●     Minimal Point Quality value is 125:

  

●     Minimal Point Quality value is 75:

System  applies to the operating system (Unix or Windows NT) used to generate the binary data: select Same if you know you are 
using the same operating system as the one used to generate the binary data, Other for the other way, Unknown if you have no 
indication.

Free Edges is used to create or not the scans representing the free edges of a mesh:

or 
Facets is used to create or not the facets of the imported mesh:

 or 

7.  Click Apply to display the cloud of points or mesh:



8.  Push the button Update to display the bounding box of the cloud of points or mesh. Use the green arrow to resize it in order to import 

only a part of the cloud of points or mesh. 

 

●     The bounding box appears every time the cursor passes over a cloud of points or a mesh. Its size corresponds to that of the visible points. 

●     If a local axis system is set as current, the file will imported in this axis systems and not in the absolute axis system as previously. If no 
local axis system is set as current, the file will be imported in the absolute axis system. 

●     Moreover, if a local axis system is set as current, the axis system of the dynamic box used to select a portion of the imported file when the 
Update button is pushed is parallel to the local axis system axis. 

The check box Replace is used to replace the current cloud of points or mesh by a new one.

9.  Once you are satisfied with the preview, click Apply and OK to finish the import of the cloud of points or mesh.

●     The name of the element created in the specification tree is the name of the original file, without its extension.

●     Undo and Redo are available.

●     V5 memorizes the data of the last imported file and proposes them at the next import action.

Importing a Set of Files

1.  Click  the Import icon . The Cloud Import dialog box is displayed. The operating mode is the same as for one file.



The files to import must: 
●     have the same format,

●     be located under the same directory.

The Selected File field looks like this: 

 

●     If you check the Grouped option (this is the default status): All the files are imported as one single cloud of points instead of several:

 

The three digit files have been imported together, resulting in one cloud of points or mesh.

 

One  cloud of points Element Cloud Import.x is created in the specification tree, with the icon of the Import command.

●     If you do not check the Grouped option: The files are imported separately.

  



 

The three digit files have been imported separately, resulting in three clouds of points. 
One cloud of points element is created in the specification for each input file, with the icon of the Import command and the name of the input 
file  (MultiImport1.1, MultiImport2.1, MultiImport3.1) .

●     You can also merge several clouds of points into one whenever necessary, using the Merge Clouds command.

 



Exporting Polygons to STL 

This task shows how to export a  mesh to binary Stl format.

Other formats available are:

●     ASCII,

●     cgo.

Open the Cloud.CATPart from the samples directory.

1.  Select the Polygon.1 and then the export icon . 

The export dialog box is displayed.

2.  One export format is available: Stl.

3.  Browse your directories and enter the target directory and file name. Then click Save.

 

●     The selection is exported with the current local axis system if any, with the absolute axis 
system otherwise.

●     You can export only one element at a time.

●     In STL Rapid Prototyping, only the Stl format is available.

http://arbre2dsy/spuCXR15/Doc/online/cfyugrvs_C2/cfyugexporttoascii.htm
http://arbre2dsy/spuCXR15/Doc/online/cfyugrvs_C2/cfyugexporttocgo.htm
http://arbre2dsy/spuCXR15/Doc/online/cfysm_C2/samples/Cloud.CATPart


Selecting Components
Selecting With a Brush

Selecting With a Box Trap
Selecting With Curves

Selecting Holes
Selecting With Flood

Inverting the Selection
Selecting Using the Activate Command

Selecting Using the Activate All Command
 



Selecting With a Brush

This task shows how to select triangles from one or multiple polygonal meshes using a brush.

Open the Bunny1.CATPart document.

1.  Click the Brush Select icon .

The Brush Select dialog box is displayed.

2.  Define radius to increase or decrease the brush size.

3.  Drag the brush over the polygonal mesh to select triangles.

4.  Click OK.

You may modify the size of the brush during the selection, simply:
❍     use the Ctrl key to add triangles to the selection, or

❍     use the Shift key to remove triangles from the selection.

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/samples/Bunny1.CATPart


Selecting With a Box Trap

This task shows how to select a portion of the polygonal mesh using a box trap.

Open the Bunny1.CATPart document.

1.  Click the Box Trap icon .

2.  Draw a box by dragging the mouse in the 3D geometry.

All the triangles inside the created box are selected.

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/samples/Bunny1.CATPart


You can adjust the size of the box using the handles on each face of the box.



Selecting With Curves

This task shows how to select triangles from the polygonal mesh enclosed by curves.

Open the Pin2.CATPart document.

1.  Select the curves delimiting the area to select.

2.  Click the Curve Select icon .

The Section icon  becomes available from the Tools Palette toolbar. 
❍     If this option is not activated, triangles are split along the curves: the result is a precise definition of the region.

❍     If this option is activated, triangles are not split: the result is a rougher definition of the region.

3.  Click inside in this area to delimit it using the selected curves.

With the Section option activated With the Section option deactivated

❍     Selecting several curves can be done holding the Ctrl 

key.

❍     Selecting a curve loop enables the selection of all 
triangles inside this loop.

 

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/samples/Pin2.CATPart


Selecting Holes

This task shows how to select surfaces boundaries of a polygonal mesh.

Open the Felix2.CATPart document.

1.  Click the Hole Select icon .

Holes, that is the boundaries of the polygonal mesh, become visible.

2.  Move the mouse onto a hole and select it.

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/samples/Felix2.CATPart


The hole is highlighted and put in the selection list.



❍     If you hold the Ctrl key while selecting the holes, the latter are appended to 
the selection. Otherwise the selection is automatically cleared before a new 
one is made.

❍     Once holes are selected, you can activate any other command.
For instance, you can use the Stitching command to stitch the polygonal mesh 
along the selected holes. 



Selecting With Flood

This task shows how to quickly select triangles that are topologically connected to the selected 
triangle.

Open the Pin1.CATPart document.

1.  Click the Flood Select icon .

2.  Click on a triangle of the polygonal mesh.

All triangles that can be reached from this initial triangle are selected.

Selecting a curve enables to extend the selection to all the connected curves 
(continuous in point).

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/samples/Pin1.CATPart


Inverting the Selection

This task shows how to reverse the selection of triangles.

Open the Pin2.CATPart document.

1.  Select triangles using curves as shown in the Selecting Using Curves chapter.

2.  Click the Invert Select icon .

The selection of triangles is inverted from the current selection.

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/samples/Pin2.CATPart


Selecting Using the Activate Command

This task shows how to activate the vertices of a polygonal mesh to define a work area.

Open the Bunny1.CATPart document.

1.  Select triangles using one of the following commands: Brush Select, Box Trap, Curve 

Select or Hole Select.

2.  Click the Activate icon .

Only the activated triangles are shown, the other triangles are hidden. 

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/samples/Bunny1.CATPart


Selecting Using the Activate All Command
This task shows how to activate all the triangles of a polygonal mesh. If an object has some of 
its triangles de-activated after running the Activate command, the Activate All command can 
restore all the triangles.

Open the Bunny2.CATPart document.

1.  Select a mesh whose triangles have been partially de-activated.

2.  Click the Activate All icon .

All the triangles become visible.

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/samples/Bunny2.CATPart


Creating
Creating Associative 3D Curves

Creating Paint Curves
Generating Meshes

Tessellating
Creating a Rough Offset

 



Creating Associative 3D Curves  
This task explains how to create a 3D curve that is associative meaning you can add or delete points (whether control points or passing 
points) both at creation time or when editing.
These curves can be created in space or lie on a geometrical element, or both. When the curve lie on a geometrical element and the later is 
modified, the curve is updated automatically, provided you choose the Automatic update option in Tools -> Options -> Mechanical 
Design -> Assembly Design -> General tab.

 
●     Selecting all 3D points

●     Editing

●     Keeping a point

●     Imposing a tangency constraint

●     Imposing a curvature constraint

●     Setting as arc limit

Open a new CATPart document.

1.  Click the 3D Curve icon .

The 3D curve dialog box is displayed.

2.  Choose the curve creation type.

 

●     Through points: the resulting curve is a multi-arc curve passing through each selected point.

 

●     Control points: the points you click are the control points of the resulting curve

 



 
●     Near points: the resulting curve is a single-arc, with a set degree and smoothed through the selected points.

 

 

You can edit the order by right-clicking the displayed text (displayed using the U, V Orders icon  from the FreeStyle 

Dashboard or the Order option from Tools -> Options menu, Shape -> FreeStyle -> General tab), and choosing a new order 
value.

 The Automatic order option enables you to automatically compute an order that will respect at best all the curve constraints.
The computed value is displayed near the Auto tag.
 

 

●     The Deviation option enables the user to set the maximum deviation between the curve and the construction points.

The result is a set degree through the selected points.

 



●     The Segmentation option enables the user to set the maximum number of arc limits. These arcs are construction points and are 
inserted into the curve automatically.
The minimum value is set to 1.

 
●     The Max Order option enables you to set a bound for the computation of a mono-arc curve. 

This option is only available with the Control Points and the Near Points types (provided the Automatic Order is selected).
❍     Control Points: when the Max order value is exceeded, the mono-arc curve becomes a multi-arc curve. As a consequence, the Max 

order value is no longer taken into account, as arcs have always 6 as order.

❍     Near Points: you cannot create a 3D curve with an order higher than the Max order value. The Max order value is always taken into 
account, whatever the result (mono-arc or multi-arcs curve).
 

The minimum value for the Max order option is set to 5 for Control Points and 2 for Near Points. If the value defined in Tools -> Options -
> Shape -> FreeStyle is set to 5, then, for Control Points, the Max order value is 6 (minimum and maximum bounds must be different).
The maximum value for the Max order is the same as defined in Tools -> Options -> Shape -> FreeStyle. If you decrease the value in 
Tools -> Options and it is lower than the Max order value, then the latter value prevails.

 
●     Smoothing options are available to parameterize the curve:

 
●     Chord Length (default parameterization)

Smoothing parameter = 0

 

 
●     Uniform

Smoothing parameter = 0

 

 
●     Smoothing parameter: enable a better control points distribution of 

the smoothed curve.  

 

 Smoothing parameter = 50 Smoothing parameter = 130

Deviation, Segmentation, and Smoothing options are only available for the Near Points creation type.



3.  Move the pointer over a point.

A manipulator is displayed allowing you to modify point location as you create the curve.
By default, this manipulator is on the last created point.

A contextual menu proposes several options to construct the 3D curve.

Right-click on the manipulator to display the contextual menu. From then on you can choose the Edit item to display the Tuner dialog box 
and enter space coordinates for the selected point, or choose the Impose Tangency item to set a tangency constraint on the curve at this 
point. 

 
4.  Click the Insert a point icon  within the dialog box.

The curve freezes.

5.  Click the segment, between two existing points where you wish to add a new point and click the point location.

 

Once the point has been created, you are back to the edition capabilities on the curve.

 

6.  Click the Remove a point icon  within the dialog box, and select one of the existing points.

The curve is recomputed immediately without the selected point.

 

7.  Click the Free or constrain a point icon  within the dialog box, then select the point.



●     If the point is a point in space (free), move the pointer close to the point or a wire to which it should be linked. You can then move the 

pointer over a geometric element and: 

❍     move the point to the indicated point by clicking

❍     press and hold the Control  key (Ctrl) to project this point onto this element according to the shortest distance from the point initial 

location.

 

●     If the point was lying on another point or a wire (curve, line, spline, and so forth), it is freed from its constraint onto this element, and 

can be moved to any new location in space.

 

You can snap a point onto a surface using the Free or constrain a point icon. The point will be lying onto the surface, but not 
constrained. It can be moved using the manipulators. 

8.  Click OK to create the curve.

A 3DCurve.xxx appears in the specification tree.

●     Check the Disable geometry detection button, when you need to create a point close to a geometric element yet without 
constraining it onto the existing geometry. 

●     Check the Hide previsualisation curve to hide the previsualisation curve you are creating.

Selecting all 3D points

It is possible to select all the points either in the specification tree or directly in the geometry. 

The Select all points contextual menu is available within the 3D curve action only, when the 3D Curve dialog box is open.

●     In the specification tree: 
❍     select the geometrical set just by clicking it, or

❍     right-click the geometrical set and choose Select all points in the geometrical set from the contextual menu, or

❍     select a point in the geometrical set, right-click it and choose Select all points in the geometrical set from the contextual menu.

●     In the geometry: select a point, right-click it and choose Select all points in the geometrical set from the contextual menu.

 



 

Contextual Options
 

Double-click your curve, right-click on the manipulator to display the contextual menu.

 
 

According to the creation type, the following options are available:

 Through Points Control Points Near points

Edit X X X

Keep this point X X X

Impose Tangency X  X 

Impose Curvature X  X

Set as Arc Limit   X

Remove this point X X X

Constrain this point X X X

Editing

1.  Right-click any of the manipulators, and choose the Edit contextual menu to display the Tuner dialog box. This option allows you to 

redefine the tangency position (X, Y, and Z axes), and its vector's step.

 

 The Relative check box enables you to redefine the tangency relative position (X, Y, and Z axes), and its vector's step.
The Reset Origin button allows you to reset the origin of the relative position.



 

Keeping a point

1.  Right-click an existing point and choose the Keep this point menu item to create a point at this location. 

A datum Point.xxx appears in the specification tree.

You can create a Point.xxx either on each control point or on the selected control points. 

Imposing a Tangency Constraint
Automatic Constraint

●     When a curve is created in Through points or Near points mode, and its first point is constrained on any point of another curve, the 
new curve automatically is tangent to the curve on which its first point is constrained. As soon as the curve's second point is created, 
the imposed tangent is displayed on the new curve.
To deactivate the default option, uncheck the Impose Tangency contextual menu on the tangent vector. 

 
Tangency Constraint on Points

When creating a 3D curve, you may want to impose tangency constraints on specific points of the curve. Then if you move the point at 
which a tangency constraint has been set, the curve will be recomputed to retain this tangency constraint at the point's new location.
Depending on the creation mode, you can impose this constraints on a limited number of points: 

●     In Through points mode: tangency can be imposed on any point

●     In Near points mode: tangency can be imposed independently on each end points only

●     In Control points mode: no tangency constraint can be imposed (end points can be constrained on other elements as described in step 
7 above. See also Constraining a Control Points Curve.

 Here is how to do it:

Open the FreeStyle_03.CATPart document.

1.  Move the pointer over an existing point, double-click it (the 3D curve dialog box appears), then right-click and choose the Impose 

Tangency menu item.

http://arbre2dsy/spuCXR15/Doc/online/cfysm_C2/samples/FreeStyle/FreeStyle_03.CATPart


Two sets of manipulators are displayed: 
●     two arrows representing the normed directions (vectors) of the tangency

●     circles representing manipulators for this vector

 

 

You can also modify the tangency constraint by: 
●     pulling the arrow

●     gliding the circles

●     double-clicking the arrow to invert the tangency direction

You can set the tangency length by clicking on the arrow then dragging the mouse.
 

Right-clicking on any of the manipulators, you can also choose to define the constraint according to an external element: 
●     Use current plane orientation (P1)/Use compass normal (P2): the tangency constraint is defined in relation to the normal to the 

current plane, possibly defined by the normal to the compass main plane
When several points are constrained on the compass, all are modified if the compass settings are changed.
When this option is checked, the direction cannot be modified directly using the vector manipulator, but only using the compass.

 

●     Constrain on element: available only when a point is already constrained on a curve. The curve being created/modified becomes 
constraint in tangency or curvature to the constraining curve at this point.

❍     Tangency constraint: in this case you can only modify the vector's norm using the Edit contextual menu, and no longer the vector's 
direction, the latter being defined by the constraining curve.

❍     Curvature constraint: in this case you neither modify the vector's norm using the Edit contextual menu, nor the vector's direction, 
the latter being defined by the constraining curve.



 

By default, when the tangency vector is constrained onto another curve, its initial direction is retained.

●     Snap on elements: the vector's direction is defined by an external element. Grabbing a manipulator, you drag the pointer over a 
curve, and the curve becomes tangent to the curve detected by the pointer. 

 

If the pointer is over a point the direction is computed as the line going from the constrained point and the detected point.
If the pointer is over a plane, the tangency is defined by the normal to this plane.  

 

●     When snapping on an element, use the Control (Ctrl) key to obtain an exact snap, taking into account both the detected element and 
the vector's norm.

●     Use the Shift key as a shortcut to activate/de-activate the Snap on elements option when passing the pointer over geometric 
elements.

Once you are satisfied with the tangency constraint you imposed, simply release the manipulator and move the pointer around to recover 
the curve preview indicating that you are ready to create a new point.
Control Points Curve Constraint

Even though you cannot impose a tangency constraint on a curve created in Control points mode, you can constrain its end points on 
another curve, as described in step 7 above. 
When setting a constraint on an end point, a text is displayed indicating the type of continuity between the two curves.



 

Right-click the text to display the contextual menu from which you can choose another continuity type: tangency, or curvature.

 
 

 

Note that: 
●     in Point continuity, only the selected point is constrained

●     in Tangent continuity, the selected point and the next one are constrained

●     in Curvature continuity, the selected point and the next two points are constrained

This means that these second and third points will be modified if you move the constrained point along the constraining element, using the 
manipulators. However, you cannot constrain these points, because they are considered as already constrained. If you try to do so, a 
warning message is displayed. Nevertheless, you can add/remove points directly after the constrained end point, and the system resets the 
points as second and third points to be affected by the constraint, where applicable.

A Continuity warning is displayed when trying to move the manipulators in a direction that is not compatible with the set constraint.

Imposing a Curvature Constraint



Right-click an existing point and choose the Impose Curvature menu item. An arrow representing the curvature direction (vector) is 

displayed. Modifying the vector direction modifies the curvature direction.

The direction of the curvature is constrained in the plane defined as normal to the tangent vector.

 

●     To impose a curvature continuity, you must ensure that a tangency continuity already exists.

●     This option is only available for the Through points and Near Points creation type.

Setting as Arc Limit

Right-click an existing point and choose the Set As Arc Limit menu item to start/stop an arc limit on this point. The curve will pass 

through this point.

 

This option is only available for the Near points creation type.

●     Use the F5 key to move the manipulators into a different plane of the compass. See Managing the Compass.

●     Use the standard shortcuts (Ctrl and Shift keys) to select, multi-select, and unselect any combination of control points on these curves.

●     You cannot add a point past the end points. To do this, you need to add a point before the end point, move the new point where the 
end point lies, then move the end point to a new location.

●     The creation plane for each free point is defined according to the current plane/compass orientation on the previous point. Therefore 
you can change creation planes within the same curve, by setting a new current plane/compass orientation on several points.

Available capabilities from the Dashboard, and/or specified through the FreeStyle Settings, are: datum creation, temporary analysis, auto 
detection (except for Snap on Control Point option), attenuation, and furtive display.

http://arbre2dsy/spuCXR15/Doc/online/cfyugfss_C2/cfyugfssut0101.htm
http://arbre2dsy/spuCXR15/Doc/online/cfyug_C2/cfyugdatum.htm


Creating Paint Curves

This task shows you how to create and draw 3D curves onto the polygon that entirely lie on it.

Open the Bunny1.CATPart document.

1.  Click the Paint Curve icon . 

The Paint Curve dialog box is displayed.

The icons from the Tools Palette are selected:

You can click the following icons to:

❍      close the dialog box

❍      gray the fitting parameters out:

From the dialog box, you can define parameters so that the 3D curve is directly fitted to the 
points of the curve being painted on the mesh.

2.  Define the degree of precision of the curve and associate a tolerance.

The higher the degree, the smoother the extracted curve.

3.  Using the mouse, select the first point on the polygon.

To paint the curve, you can either click point by point (subsequently create new 
segments) or drag the mouse.

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/samples/Bunny1.CATPart


4.  Double-click on the polygon to end the painting and exit the command.

The curve (identified as Mesh Curve.xxx) is added to the specification tree.
 

Hold the Ctrl button to complete the loop, and therefore exit the command

❍     You can now paint a curve using an existing curve that lies on the polymesh, either by:
■     clicking a vertex to start or continue the paint curve, or

■     snapping onto the curve and selecting a point on this curve.



 



Generating Meshes

This task shows you how to generate a polygonal mesh from curves and selected triangles.

Open the Vase2.CATPart document.

1.  Click the Generate Mesh icon . 

The Generate Mesh dialog box opens.

2.  Using the Ctrl key, select the curves and triangles (if necessary).

3.  Define the tolerances:

❍     Point Tolerance: tolerance for the fitting points

❍     Curve Tolerance: tolerance for the fitting curves

❍     Tessellation: resolution of the generated mesh

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/samples/Vase2.CATPart


4.  Click Apply to preview the polygonal mesh.

5.  Click OK to generate it.

6.  Perform the operation again with the other set of curves.

The generated mesh passes through the selected curves and vertices of the selected 
triangles.



The mesh (identified as Mesh Generation.xxx) is added to the specification tree.



Tessellating

This task shows how to tessellate a surface and convert it into a polygonal mesh.

Open the Tessellate1.CATPart document.

1.  Click the Tessellate icon .

The Tessellate dialog box opens.

2.  Select the surface(s) to be tessellated.

3.  Define the Tolerance parameter to control the density of the triangles created based 

on the curvature of the surface. The smaller the value, the greater the number of 

triangles in curved areas.

4.  Select the Edge Length option to control the edge length of the generated triangles 

and enter the length of the triangles. The smaller the edge length, the greater the 

number of triangles.

5.  Click Apply.

The tessellation feature (identified as Tessellation.xxx) is added to the specification 
tree.

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/samples/Tessellate1.CATPart


Tolerance=0.1mm
Edge Length=100mm
 

Tolerance=1mm
Edge Length=100mm
 



Tolerance=0.1mm
Edge Length=10mm
 

Tolerance=1mm
Edge Length=10mm



Rough Offset
This task will show you how to create offsets from complex geometries, that may contain either 
sharp or smooth features. The offset mesh will present no self intersections, too small features 
being eliminated automatically. The offset distance will be respected all along the mesh.

  
The mesh to process:

●     may not be non-manifold. You should use the Mesh Cleaner.

●     may have one hole at the most.

●     may be watertight or have one single boundary.

This action requires a Shape Sculptor license.

Open the FuzzyOffset1.CATPart from the samples directory

 1.  Click the Rough Offset icon  and select the mesh.

 

http://arbre2dsy/spuCXR15/Doc/online/cfyugrvs_C2/cfyugmeshcleaner.htm
http://arbre2dsy/spuCXR15/Doc/online/cfysm_C2/samples/FuzzyOffset1.CATPart


 
2.  A white arrow symbolizes the Offset Distance and its direction (positive, negative, in 

both directions) as you set it.

3.  Set the Granularity that controls the coarseness of the offset mesh. The smaller the 

value of Granularity, the higher the quality of the offset mesh.

 With a high Granularity value:

With a low Granularity value:



Be aware that a small Granularity value will require more time and more memory to compute 
the offset mesh. In extreme cases, the computation may even be impossible. You will then be 
requested to increase the Granularity value.

4.  Push one of the Direction icons to determine how the offset is carried out and click 

Apply:

 In the pictures below, the original mesh has its containment box highlighted.

 One side

With a positive Offset Distance:

With a negative Offset Distance:



 

 One side extended

With a positive Offset Distance:

With a negative Offset Distance:



 Both sides

With a positive Offset Distance (a negative distance is not relevant):

5.  Click OK to create the offset mesh. An Offset.x element is created in the specification 

tree. Or click Cancel to exit the action without creating any mesh.

 



Editing
Decimating Meshes

Refining
Smoothing

Smoothing With a Brush
Deleting Triangles

Extracting Triangles
Copying Triangles

Slicing
Intersecting Meshes

Trimming or Splitting a Mesh
Stitching

 

http://arbre2dsy/spuCXR15/Doc/online/cfyugrvs_C2/cfyugmeshstrimsplit.htm


Decimating Meshes
This task will show you how to decimate a mesh. 

Decimation is a command reducing the triangle count of a mesh for a quicker execution of 
commands. It also reduces the memory requirements for the model. Many large meshes can 
be represented accurately with less triangles.

Decimation can be performed on the entire region or a selected region of the mesh.

 
The mesh must be exempt of Non Manifold problems, even on non-active areas. You should 
use the Mesh Cleaner.

Open the SmoothMesh01.CATPart from the samples directory

 

 

1.  Click the Decimation icon  and select a mesh. The dialog box is displayed:

 

http://arbre2dsy/spuCXR15/Doc/online/cfyugrvs_C2/cfyugmeshcleaner.htm
http://arbre2dsy/spuCXR15/Doc/online/cfysm_C2/samples/SmoothMesh01.CATPart


2.  Check the type of decimation you want to apply:

●     by Chordal Deviation if you want to preserve the shape of your model, even in 

areas with a high curvature,

●     by Edge Length if you want to remove triangles with tiny edges and obtain a 

more uniform mesh. However this may result in a loss of accuracy in areas with a 

high curvature.

 
3.  Then, decide how you want the decimation to stop:

●     For a decimation by Chordal Deviation, you can check Maximum and enter a 

value. It is the chordal deviation that should not be exceeded during decimation. 

Decimation stops when the chordal deviation limit has been reached.

●     For a decimation by Edge Length, you can check Minimum and enter a value. 

The command stops when further decimation could collapse edges of length 

greater than the value entered.

●     For both types of decimation, check Target Percentage if you want to obtain a 

given final number or percentage of triangles. Enter either the percentage value 

or the Target Triangle Count. Those fields are linked to each other and 

updated simultaneously.

Current Triangle Count indicates the current number of triangles, either of the 

original model when you enter the action, or of the result model when you have 

clicked Apply.

 



 Decimation with a Chordal Deviation at 70%:

 Decimation by Edge Length set at 70%:



 
4.  You may need to control the decimation of free edges, when a rectangular shape sees 

its corners cut off after decimation. You can avoid this by checking Free Edge 

Deviation. This activates the maximum allowable deviation that can occur for vertices 

on the boundary. The resulting decimated boundary will not be at a distance greater 

than this parameter from the original boundary. 

 

 
5.  The chordal deviation that can be used as a stopping criterion is an approximation of 

the chordal deviation between the original mesh prior to decimation and the decimated 

mesh. Therefore it may be useful to know the maximum distance and the mean 

distance between the original mesh and the result mesh at the end of the command.

To do so, check Analysis before clicking Apply. At the end of the decimation, the maximum 

and the mean deviation will be reported as shown below. Unlike the value entered in the 

Maximum field, they are the true deviations between the original mesh and the result mesh.



●     However, Analysis may be time consuming, especially for large models. We recommend 
that you turn it off when you do not need it.

●     The meshes can be decimated in several steps (click Apply= one step). The deviations 
displayed are those between the original model and the last result (not those between the 
previous and the current results). For this reason, the deviations will be increasing in value 
after each Apply.

●     Any selection change resets the original model for the analysis.

●     Undo is not taken into account by the Analysis.

 At each Apply, a progress bar is displayed. A Cancel button is available to stop the 
decimation.

6.  Click OK to confirm the decimation once you are satisfied with the result.

 



Refining
This task shows how to refine a polygonal mesh.

Refinement is a command increasing the details of a polygonal mesh by splitting its triangles. It can be performed on the entire mesh or a 
selected region of the mesh. 

Refinement preserves the selection: each selected triangle will be removed from the mesh and replaced with two triangles. The two new 
triangles lie in the same plane as the original triangle. Additional triangles besides those selected may be refined and these will not be placed 
in the selection after refinement.

Open the Refine1.CATPart document.

1.  Click the Refine icon . 

The Refine dialog box is displayed.

2.  Select the polygonal mesh.

You can use the Wireframe mode from the View toolbar to display the number of triangles.

3.  Click Apply to preview the refinement.

4.  Click OK to exit the command.

 

Before refinement  After refinement 

 

●     You can click Apply in the dialog box as many times as desired to perform a more precise 

refinement.

●     You can perform several selections of triangles while in the command.

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/samples/Refine1.CATPart


Smoothing

This task shows how to smooth the vertices of a polygonal mesh.

Smoothing can be performed on the entire mesh or a selected region of the mesh.

Open the Bunny1.CATPart document.

1.  Click the Smooth icon . 

The Smooth dialog box is displayed.

2.  Select the polygon.

3.  Define the number of Steps of the smoothing between 1 and 100.

4.  Define the Pressure value between 0 and 100.

A value of 0 means there is no smoothing, and a value of 100 corresponds to the maximum smoothing. 

5.  Click Apply to preview the smoothing.

The Maximum deviation is displayed.

6.  Click OK.

The example above shows a smoothing using the 
following values:
Steps = 1
Pressure = 10

The example above shows a smoothing using the 
following values:
Steps = 1
Pressure = 90

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/samples/Bunny1.CATPart


  

The example above shows a smoothing using the 
following values:
Steps = 40
Pressure = 10

The example above shows a smoothing using the 
following values:
Steps = 40
Pressure = 90

 
●     The Preserve Volume option enables to keep the volume of the polygonal mesh 

after the smoothing (as you can see in the fourth example, the volume was not 

kept).

●     The Smooth Boundaries option enables to smooth the boundaries (free edges) 
of the polygonal mesh.

●     The Tolerance value enables to check if any of the vertices moved by a distance 
greater than the user specified tolerance. If the tolerance is violated, the vertices 
are restored to their original position and the smoothing is not performed. If 
successful, the Maximum Deviation of the vertices is displayed.



Smoothing With a Brush

This task shows how to locally smooth the polygonal mesh using a brush.

Open the Bunny1.CATPart document.

1.  Click the Brush Smooth icon .

The Brush Smooth dialog box is displayed.

2.  Define the Radius value corresponding to the size of the brush.

3.  Define the Pressure value between 0 and 100.

A value of 0 means there is no smoothing, and a value of 100 corresponds to the maximum 
smoothing. 

4.  Choose the smoothing type:

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/samples/Bunny1.CATPart


❍     Flatten: the mesh tends to become flatter as it is being smoothed.

❍     Round: the mesh is smoothed while keeping the rounded shapes.

5.  Click Apply to preview the smoothing.

6.  Click OK.

 

Flatten  Round



Deleting Triangles

This task shows how to delete selected triangles of a polygonal mesh.

Open the Pin1.CATPart document.

1.  Select the triangles to delete using one of the selection components.

In our example, we chose the Curve Select component.

2.  Click the Delete Triangles icon . 

The selected triangles are deleted from the polygonal mesh.

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/samples/Pin1.CATPart


Extracting Triangles

This task shows how to create a mesh by extracting a selection of triangles from a polygonal 
mesh.

Open the Pin3.CATPart document.

1.  Select the triangles to delete using one of the selection components.

In our example, we chose the Curve Select component.

2.  Click the Extract Triangles icon . 

A mesh is created with the selected triangles: they are extracted and deleted from the 
original mesh and added to a new polygonal mesh.
This new mesh (identified as Polymesh.xxx) is added to the specification tree. 

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/samples/Pin3.CATPart


Copying Triangles

This task shows how to create a mesh by copying triangles from of a polygonal mesh.

Open the Pin3.CATPart document.

1.  Select the triangles to delete using one of the selection components.

In our example, we chose the Curve Select component.

2.  Click the Copy Triangles icon . 

A mesh is created with the selected triangles: they are copied from the original mesh 
and added to a new polygonal mesh.
This new mesh (identified as Polymesh.xxx) is added to the specification tree. 

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/samples/Pin3.CATPart


Slicing

This task shows how to slice a polygonal mesh using curves and scans.

Open the Pin3.CATPart document.

1.  Click the Slice icon .

The Slice dialog box is displayed.

2.  Select a polygonal mesh.

3.  Select one or more curves or scans.

The curves do not need to lie on the mesh: if they do not lie, they will be 
projected onto the mesh using a normal projection, before the slicing operation.

4.  Click Apply.

All boundaries (free edges) are highlighted.

5.  Click OK.

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/samples/Pin3.CATPart


A hole is created in the polygonal mesh.
 

A refinement will be performed on the mesh in the area of the slicing entity 
(curve or scan).



Intersecting Meshes

This task shows how to slice two polygonal meshes along their intersection.

Open the Intersect1.CATPart document.

1.  Click the Mesh Intersect icon .

The Mesh Intersect dialog box is displayed.

2.  Select the first mesh.

3.  Press the Ctrl key and select the second mesh.

Their intersection is highlighted in blue.

4.  Select intersection type:

❍     Slice: meshes are sliced

❍     Create Curve: meshes are not sliced, however curves are created at each intersection. These curves appear in the 

specification tree as Intersection Curve.xxx.

5.  Click Apply to preview the intersections.

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/samples/Intersect1.CATPart


Slice Create Curve

6.  Click OK to exit the command.



Trim/Split  
This task will show you how:

●     to split a mesh in several meshes (displayed in different colors below):

●     and/or trim portions of the mesh delimited by curves, planes, surfaces or other meshes:



 

2.  Select the mesh to trim or split. It can consists of several cells.

3.  Select the Cutting elements . 

●     The mesh must be exempt of Non Manifold problems, even on non-active areas. You should use the 
Mesh Cleaner.

●     Keep the portion of curves not taken into account at intersections as short as possible.

  
Open TrimSplit1.CATPart from the samples directory.

1.  Click the Trim/Split icon . The dialog box is displayed.



  

 

Those input elements are highlighted in the graphic area and listed in the dialog box. To remove a 
cutting element, select it in the dialog box list and push the Remove button. To replace a cutting 
element with another, select is in the dialog box list, push the Replace button and select the new 
cutting element.

  
To define an area, the projection curves of the cutting elements must intersect each other or intersect 
free edges.

This case defines two areas:

This case defines nine areas:

They can be:

●     scans,

●     curves,

●     planes,

●     surfaces,

●     meshes.



This case is not valid: the projection curve does not intersect any free edge. In some cases, changing 
the Projection type may solve the problem.



4.  Select the Projection type

When scans or curves are used as cutting elements, those entities are close to the mesh but not on the 
mesh. To compute the intersection, it is necessary to project those scans or curves on the mesh to 
create intersection curves. Four  projection options are proposed:

●     View: the projection is done along the view direction,

●     Compass: the projection direction is defined using the compass,

●     Normal: the projection is normal to the mesh,

●     Along a direction: the projection is done along the direction defined by the user.

The projection option applies to all cutting elements.



 

5.  Check Preview if you want to see the projection of the cutting elements on the mesh. 

This is an example of the Preview of a plane.

For better performances you should not activate the preview unless absolutely necessary.

6.  Decide whether you want to trim or split the mesh:

If you want to split the mesh:

7.  Make sure the Split option is checked. This makes the Apply button available.

8.  Click Apply. The action creates several new meshes. 

If you want to trim the mesh:

7.  Make sure the Trim option is checked. This makes the scissors and crossed-scissors 

available.

8.  Use the scissors or crossed-scissors to define the portions to be kept or removed:

Push the scissors button and pick the area(s) you want to remove, or 



push the crossed-scissors button and pick the area(s) you want to keep. 





Click a scissors or crossed-scissors icon to delete one occurrence, or use the contextual menu.

Push the Remove All button to delete all occurrences, or use the contextual menu.

 
●     Unselected areas have the opposite status. 

●     You can not mix instances of scissors and crossed-scissors.

A contextual menu is available on scissors and crossed-scissors:

 

●     Delete: Deletes the occurrence,



 

●     Delete All: Deletes all occurrences,



●     Invert All: Replaces all occurrences of scissors by crossed-scissors and vice-versa.



  

 

9.  Select a Result option:

 

●     if you check Distinct, the output meshes will be distinct elements,

 

 

 

●     If you check Grouped, the new meshes will be cells grouped in a single body.

  



Keep Initial controls whether a new mesh is created in the specification tree or if the input mesh is 
replaced by another when the command is executed.

If Keep Initial is checked:

●     the input mesh is sent to the NoShow and remains in the specification tree, 

●     the output meshes are created in the specification tree and the graphic area:

❍     Distinct is checked

●     Grouped is checked



If  Keep Initial is not checked:

●     if Distinct is checked, the input mesh is removed from the specification tree, the output meshes are 
created in the specification tree and the graphic area. 

●     if Grouped is checked, the result multi-cells mesh replaces the input mesh: 
❍     the input mesh is removed from the graphic area but its name remains in the specification tree, 

❍     the result multi-cells mesh is created in the graphic area and under the name of the input mesh 
in the specification tree.



We recommend that you do not keep initial large meshes.

 

10.  Click Apply to preview the result.

11.  Click OK to validate and exit the action.



Stitching

This task shows how to stitch two or more polygonal meshes into one mesh, along their free 
boundaries.

Open the Felix2.CATPart document.

1.  Slice the two polygonal meshes as shown in the previous task.

2.  Click the Stitch icon .

The Stitching dialog box is displayed.

3.  Select a hole along the boundary of the first mesh.

The blue arrow shows you which boundary is selected.

4.  Holding the Ctrl key, select a hole along the boundary of the second mesh.

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/samples/Felix2.CATPart


The blue arrow shows you which boundary is selected.

5.  Adjust the tolerance using the spinners (in our scenario, it is set to 2.5 mm).

If a too low value is set, holes still remain.

6.  Click Apply to preview the stitching.

Meshes are merged and stitched into one mesh.

Here the mesh is displayed as flat. Refer to Display Options and Graphic Properties for 

further information.



7.  Click OK to exit the command.

The element (identified as Stitching.xxx) is added to the specification tree.

Stitching cannot create non-manifold edges.



Modeling
Editing Curves Using Control Points

Projecting Curves
Extracting Curves
Sculpting Curves

Embossing
Pushing / Pulling a Mesh

Sculpting Surfaces
Creating Sharp Edges
Modeling Using a Grid

Modeling Using an Interactive Grid
 

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/dssugbt0530.htm


Editing Curves Using Control Points 

This task explains how to modify a curve using its control points.

Use the Control Points dialog box to modify the curve according to certain predefined 
laws.

Open the FreeStyle_01.CATPart document.

1.  Select the curve you wish to edit.

 

2.  Click the Control Points icon:  

 The Control Points dialog box appears.

 

 Control points and lines are displayed, along with the 3D compass and the curve 
degree.

http://arbre2dsy/spuCXR15/Doc/online/cfysm_C2/samples/FreeStyle/FreeStyle_01.CATPart


 

●     If you select a curve that has been created outside the FreeStyle workbench, 
and the curve is not a NUPBS curve (Non-Uniform Polynomial  B-Spline), the 
Converter Wizard will be automatically displayed when the curve cannot be 
exactly converted, see Approximating/Segmenting Procedural Curves. This 
allows you to control the conversion tolerance. 
However, when a curve can be exactly converted, such as a spline, or line for 
example, the Converter Wizard is not displayed, the conversion is done 
automatically and a message is issued. In this case, the Exact text is displayed 
on the element for information.

●     Planes and lines are used to quickly orientate the compass in the control points 
command. Therefore if you select a plane or a line, it will modify the compass 
orientation.

●     By default all control points and mesh lines are selected. Click a specific point to 
deform the surface at this point only, or select a set of points using the Ctrl-key 
or Shift-key while clicking (multi-selection capabilities). The same applies to 
mesh lines.

3.  Move the pointer over a point or a line.

 Arrows are displayed according to the Support and Law options active in the 
Control Points dialog box:

●     Support defines the type of translation to be applied

●     Law defines the type of deformation that is to be applied when several control 
points have been selected.
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4.  Pull on the arrow matching the direction in which you want to deform the curve.

 

5.  Use the Dashboard to display the order number directly on the curve, using the U, 

V Orders icon:  

 The value is displayed on the curve.



6.  Use the contextual menu to choose the order number for the curve.

 

If you increase the order number to 11, the result is:

 

7.  Click OK in the Control Points dialog box to validate the modifications.

Further modification options are available from the More... button of the Control 
Points dialog box:



 

●     To perform a quick analysis of the mesh line inflection, select the Inflections 
option.

●     Freezing of the selected points (no other can be selected) and of the Support 
option.

●     Dynamic display of the initial curve and of the delta as you pull on the control 
points.

●     Global selection/de-selection of control points using the Select All  and 

De-Select All  icons, without having to click the geometry.



Projecting Curves

This task shows you how to project points or curves on surfaces.

Open the Project1.CATPart document.

1.  Press the Ctrl key and select the curve(s) you want to project.

2.  Click the Project Curve icon . 

The Project Curve dialog box is displayed.

3.  Choose the projection orientation from the Projection dialog box:

❍     View: projection according to the current view

❍     Compass: projection according to the compass

❍     Normal: projection normal to the surface

4.  Press the Ctrl key and select the surface or set of surfaces on which the curve(s) 

should be projected. 

5.  Click Apply to preview the projected curves on the target surface.

Projection according to
the current view
 

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/samples/Project1.CATPart


Projection according to
the compass orientation
 

Projection according to
the normal to the surface

6.  Click OK to create the projected curves.

Curves (identified as Project Curve.xxx) are added to the specification tree.
 

The Projection command is associative: may you modify an input point or curve, 
the result of the projection is automatically updated while modifying the input 
curve.

To be able to edit and modify a point or curve, the latter cannot be datum 
elements.



Extracting Curves

This task shows how to create 3D curves from one or more selected holes.

Open the Vase4.CATPart document.

1.  Click the Curves Extract icon .

The Extract Curves dialog box is displayed. It is empty.
The icons from the Tools Palette become available:

2.  Click the following icons to:

 show the fitting parameters in the dialog box

❍      un-gray these parameters out

From the dialog box, you can define fitting parameters so that 3D curves are directly 
fitted to the points of the curve being created from the holes.

3.  Define the degree of precision of the curve and associate a tolerance.

The highest the degree, the less precise the curve.
Holes are displayed on the polygonal mesh.
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4.  Select a hole.

A light blue square handle appears on the hole and a blue dot handle indicates the start 
and end of the hole curve.

The square handle lets you break the hole curve into multiple segments:

5.  Click it and move it along the hole to break the curve into two segments.

6.  Repeat the operation as much as needed to break the curve in additional segments.



The dot handles let you modify the starting and ending point of the curve segments:

7.  Click a dot and move it along the hole to change the starting and ending point of the 

segment.

You can right-click a dot to remove it.

The hole is segmented in as many curves as there are handles.

8.  Click Apply to create the curves.

Curves (identified as Curve.xxx) are added to the specification tree.

9.  Click OK to exit the command.



Sculpting Curves

This task shows you how to sculpt a polygonal mesh a curve or a set of connected curves.

Open the Pin4.CATPart document.

1.  Click the Curve Sculpt icon . 

The Curve Sculpt dialog box is displayed.

The Section icon  becomes available from the Tools Palette toolbar. 
❍     If this option is not activated, the mesh is split along the curves.

❍     If this option is activated, the mesh are not split along the curves.

2.  Holding the Ctrl key, select the curves to sculpt with.

3.  Select the polygonal mesh.

4.  Click Apply.

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/samples/Pin4.CATPart


5.  Define the profile:

❍     Smooth

❍     Sharp (used in our example)

❍     Circular

You can check the Dynamic button to automatically sculpt the mesh on the fly.

6.  Define the influence area around the curves:

❍     Check the Show button to display the area that is affected by sculpting on the 

polygonal mesh. Use the manipulators to define the area (as shown in the picture)

❍     Click Refine to refine the sculpt by adding triangles

❍     Check the Uniform button and use the spinners if you wish to force a constant 

transition width along the curves.



If you uncheck the Uniform button, you are able to define the influence area curve by 
curve.
Simply position the manipulator on the curve whose area you wish to modify and drag 
the manipulator to the desired transition width.

7.  Define the offset:

❍     Check the Show button to display the change to the sculpting curve before applying 

it to the polygonal mesh. Use the manipulators to define the offset (as shown in the 

picture)

❍     Check the Uniform button and use the spinners if you wish to force a constant 

offset.



If you uncheck the Uniform button, you are able to define the offset curve by curve.
Simply position the manipulator on the curve you wish to modify the offset and drag 
the manipulator to the desired offset.

8.  Click OK to end the sculpt.

Here is the result:



Embossing

This task shows how to emboss a polygonal mesh using curves.

Open the Pin4.CATPart document.

1.  Click the Emboss icon . 

The Emboss dialog box is displayed.

2.  Holding the Ctrl key, select the curves to be used in embossing.

3.  Select the mesh to emboss (you can select inside or outside the curves, in our example 

we selected outside).

4.  Click Apply.

5.  Define the profile:
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❍     Smooth (used in our example)

❍     Sharp

You can check the Dynamic button to automatically sculpt the mesh on the fly.

6.  Define the influence area around the curves:

❍     Check the Show button to display the area that is affected by embossing on the 

polygonal mesh. Use the manipulators to define the area (as shown in the picture)

❍     Click Refine to refine the embossed area by adding triangles, therefore increasing 

the mesh resolution.

❍     Use the spinners to force a constant transition width along the curves.

7.  Define the offset:

❍     Check the Show button to display the change to the curves to be embossed before 

applying it to the polygonal mesh.

Use the magenta arrow to define the offset (as shown in the picture)

❍     Use the spinners to force a constant offset.



You can change the offset direction, using:
❍     either the spinners or the cyan arrow to define a value for X, Y, and Z.

Here is an example with X= -50, Y=0, and Z=100.

❍     the compass: Adjust the compass to the desired direction by moving the compass 
on the selected mesh, then right-click the offset arrow and select Align to 
compass contextual menu.
The offset direction is now aligned with the compass direction.

Make sure the Show button is checked.



8.  Click OK to exit the command.

 
Selecting multi-loops

 It allows you to emboss a more complex shape on the mesh.

Open the EmbossMultiCurves1.CATPart document.

1.  Click the Emboss icon . 

The Emboss dialog box is displayed.

2.  Holding the Ctrl key, successively select the sketches of the outer loop and the inner 

loop.

3.  Select the mesh to emboss outside the inner loop and inside the outer loop.

4.  Set the Offset as 10mm.

5.  Click Apply.
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Pushing / Pulling a Mesh

This task shows how to locally modify a polygonal mesh by pushing or pulling a point on the mesh.

Open the PushPull1.CATPart document.

1.  Click the Push/Pull icon .

The Push Pull dialog box is displayed.

2.  Define the profile of the sculpted area:

❍     Smooth

❍     Sharp 

❍     Circular

The sculpted area can be defined by:

❍     a point

1.  Select a point on the mesh.

2.  Define the influence area around the point:

■     Check the Radius button to define a constant influence area (that is the circle around the center point) and display the 

magenta arrow in the geometry.

■     Use the spinners to define the push/pull magnitude.

■     Use the arrow to define the push/pull direction.

3.  Click Apply to preview the push/pull.

The Radius button is grayed out.
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❍     one or more curves forming a closed loop

❍     one or more curves and a part of the mesh boundary

❍     the mesh boundary

Make sure the Radius button is unchecked.

1.  Select the curve(s) or mesh boundary (hold the Ctrl key if you selected several curves).

In our scenario, we selected three curves.

2.  Click a point inside the curve(s) or boudary.

3.  Click Apply.

3.  Define the offset:

❍     Check the Show button to display the cyan arrow in the geometry. 

❍     Use either the spinners or the arrow to define the offset.

 

Point selection  Three-curve selection
  

You can click Refine to refine the sculpt by adding triangles, therefore increasing the mesh resolution.  

Point selection with Smooth profile Point selection with Circular profile
  



Three-curve selection with Sharp profile Three-curve selection with Circular profile
  

One curve & mesh boundary selection with Smooth profile One curve & mesh boundary selection with Sharp profile
  

Mesh boundary selection with Smooth profile Mesh boundary selection with Sharp profile

4.  Click OK to exit the command.

You can define the offset direction using:

❍     either the spinners or the cyan arrow to define a value for X, Y, and Z.

Here is an example with X= 10, Y=3, and Z=25.

❍     the compass: Adjust the compass to the desired direction by moving the compass on the selected mesh, then right-click the 

offset arrow and select Align to compass contextual menu.

The offset direction is now aligned with the compass direction.





Sculpting With Surfaces

This task shows how to modify a portion of a polygonal mesh with a NURBS surface.

Open the SurfaceSculpt1.CATPart document.

1.  Click the Surface Sculpt icon . 

2.  Press the Ctrl key and select four curves that form the closed contour of the region to 

be sculpted.

3.  Click on the polygonal mesh inside the curves. 

Control points are displayed as well as the Control Points dialog box.

4.  Sculpt the polygonal mesh using the Control Points tool. 
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For further information, refer to the Editing Surfaces Using Control Points chapter 
in the FreeStyle Shaper, Optimizer, & Profiler documentation

5.  Click OK in the Control Points dialog box.



Creating Sharp Edges
This task shows how to reconstruct or create sharp edges and corners from a polygonal mesh 
with a fillet of constant radius.
It can run in a basic or advanced mode.
Open the SharpEdge1.CATPart document for basic mode.
Open the SharpEdge2.CATPart document for advanced mode.

1.  Click the Sharp Edge icon . 

The Sharp Edge dialog box is displayed.

2.  Holding the Ctrl key, select the curves (in case there are several curves).

3.  Select the polygonal mesh.

4.  Click Apply.

 
Basic Mode

 It provides tools to adjust the area around the curve that needs to be sharpened. The 
command can then reconstruct the the sharp edge from the fillet from this input. 

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/samples/SharpEdge1.CATPart
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1.  Define the influence area around the curves:

❍     Check the Show button to display the area that is affected by sharpening on the 

polygonal mesh. Use the manipulators to define the area (as shown in the picture)

❍     Click Sharpen to sharpen the mesh.

❍     Use the spinners to set a radius for the influence area.

2.  Define the offset:

❍     Check the Show button to display the change to the sharpened curve before 

applying it to the polygonal mesh. Use the manipulators to define the offset (as 

shown in the picture)

❍     Check the Uniform button to force a constant offset. Use the spinners to define an 

offset value.



3.  Click OK to create the sharp edge.

Here is the result:

 
Advanced Mode

 

It provides tools to generate the theoretical edge curve (in the space above the edge or the 
fillet) and to adjust the area around the curve(s) that needs to be sharpened. In this mode, it 
enables to generate and edit the theoretical curves and therefore to control the shape of the 
reconstructed sharp edge.

 
1.  Define the influence area around the curves:

❍     Check the Show button to display the area that is affected by sharpening on the 

polygonal mesh. Use the manipulators to define the area (as shown in the picture)

❍     Click Sharpen to sharpen the mesh.

❍     Use the spinners to set a radius for the influence area.

2.  Define the offset:



❍     Check the Show button to display the change to the sharpened curve before 

applying it to the polygonal mesh. Use the manipulators to define the offset (as 

shown in the picture)

❍     Uncheck the Uniform button define the offset curve by curve.

Simply position the manipulator on the curve you wish to modify the offset and drag 

the manipulator to the desired offset.

3.  Click OK to create the sharp edge.

Here is the result:



Modeling Using a Grid

This task shows to deform a mesh using a grid tool. It enables several deformations: 
stretching, shearing, twisting, scaling, and modeling.

Open the Felix1.CATPart document.

1.  Click the Grid Modeling icon . 

The Grid Modeling dialog box is displayed.

2.  Select the mesh to be deformed.

A grid tool frames the mesh: it corresponds to the bounding box of the mesh.

You can also select the mesh before entering the command.
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Dots are displayed in the middle of each face of the box.

Degree and Continuity tools are also displayed on each face: you can choose to hide 

them by deselecting the icons in the Tools Palette toolbar:

The resolution of the grid can be increased or decreased: right-click a degree tag and 
select a new degree in the contextual menu. You can also click a degree tag to 
progressively increase the value or Shift-click to decrease the value.

3.  Define the deformation mode:



❍     Face Grid: you can only manipulate one entire face in the grid. Three operations 

can be performed:

■     : Translation

■     : Rotation

■     : Scaling

❍     Point Grid: you can stretch vertices and edges individually in the grid tool. The 

direction of the translation can be controlled using the compass.

❍     The Law icon  lets you to manipulate more than one face by dragging the 

manipulator on one face.

You can use different types of laws: identical, linear, concave, convex or bell.

The Law option is only available with the Face Grid mode.

4.  Define the Display options to control the direction in which the direction in the tool are 

displayed.

You can check the Dynamic Update option to control the deformation update. If 
unchecked (by default), the deformation is applied at the end of the 
manipulation.

5.  Depending on the deformation mode you chose, move the mouse close to any of the 

dots (Face Grid) or any of the vertices or edges (Point Grid). Arrows appear letting to 

stretch the model.



Face Grid Point Grid

6.  Click OK when you are satisfied with the modeling.

It could look like this:



Modeling Using an Interactive Grid

This task shows to deform a portion of a mesh using a grid tool. It enables several 
deformations: stretching, shearing, twisting, scaling, and modeling.

Open the Felix1.CATPart document.

1.  Click the Interactive Grid Modeling icon . 

The Grid Modeling dialog box is displayed with all the options grayed out.

2.  Click and drag the mouse in the 3D geometry.

A grid tool frames the portion of the mesh: it corresponds to the bounding box of the 
mesh.

You can adjust the size of the box using the handles on each face of the box.
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3.  Now click the Deform button in the dialog box to start deforming the portion of the 

mesh.

Dots are displayed in the middle of each face of the box, as well as degree and 

continuity tools.

Degree and continuity tools are selected in the Tools Palette:



You can click the following icons to:

❍      hide the degree tools

❍      hide the continuity tools

The resolution of the grid can be increased or decreased: right-click a degree tag and 
select a new degree in the contextual menu. You can also click a degree tag to 
progressively increase the value or Shift-click to decrease the value.

4.  Define the deformation mode:

❍     Face Grid: you can only manipulate one entire face in the grid. Three operations 

can be performed:

■     : Translation

■     : Rotation

■     : Scaling

❍     Point Grid: you can stretch vertices and edges individually in the grid tool. The 

direction of the translation can be controlled using the compass.

❍     The Law icon  lets you to manipulate more than one face by dragging the 

manipulator on one face.

You can use different types of laws: identical, linear, concave, convex or bell.

The Law option is only available with the Face Grid mode.

5.  Define the Display options to control the direction in which the direction in the tool are 

displayed.

You can check the Dynamic Update option to control the deformation update. If 
unchecked (by default), the deformation is applied at the end of the 
manipulation.

6.  Depending on the deformation mode you chose, move the mouse close to any of the 

dots (Face Grid) or any of the vertices or edges (Point Grid). Arrows appear letting to 

stretch the model.



 

Face Grid  Point Grid

7.  Click OK when you are satisfied with the modeling.

It could look like this:



Analyzing
Display Options

Analyzing Using Highlights
Analyzing Using Curvature
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Display Options and Graphic Properties

This  task shows how to change the display option of clouds of points.

Open the Visu1.CATPart model the from the samples directory. It consists of four clouds of 
points: 

●     a mesh,

●     a cloud of points,

●     a set of scans,

●     a set of grids.

Their default colors are respectively: 
●     orange,

●     green,

●     cyan,

●     cyan.

The display options are available from the Cloud Display Options box. Further graphic 
properties are available from the Edit/Properties menu, in the Graphic tab. 

From the Cloud Display Options box, you can:

●     Choose the sampling of clouds of points (N of 100 points are displayed). 

●     Choose to display scans or grids as polylines, points, or both. 

●     Choose to display triangles, free edges, non-manifold edges of meshes. You can also choose 
their display mode: flat or smooth. 

From the Edit/Properties menu, you can:

●     Choose the fill color of the mesh and its transparency level,

●     Choose the color and symbol of the points of a cloud,

●     Choose the color, type and thickness of scans and grids,

●     Choose to elements pickable or not.

Cloud Display Options box 

The images below are only examples.

1.  Click the Cloud Display  icon  at the bottom of the screen. The Cloud Display 

Option dialog box is displayed.
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2.  Select the cloud to modify. Display options are proposed according to the type of the 

cloud selected:

 

Following options are not yet available: 

●     Protected,

●     Orientation,

●     Shrink,

●     Normal.

3.  For the cloud of points, you can choose to display only a percentage of the points making 

the cloud, using the Sampling option. By default, 100% of the points are displayed. You 

can change this value with the associated spinner.



Sampling=100 Sampling=25

The Symbol options are not available in that box, but in the Graphic Properties menu.

For the sets of scans or grids, you can display them as line of points or points or both: 

For the mesh, you can: 
●     display the triangles, 



 
●     visualize only the vertices for a lighter display (do not forget to de-activate the Smooth, Flat 

or Triangles options)

 instead of 

 

 
●     the free edges in yellow, 

●     the non-manifold facets and their vertices in bold white lines. 



●     If you choose the display of triangles, the triangles accepting a non-manifold edge have their 
edges displayed as regular white lines. 

 



●     display the  mesh as a smooth or a flat mesh.

 or 

 

The free edges displayed are those of the complete cloud of points: 
●     if you activate only a portion of a cloud of points, the free edges of that portion are not 

displayed.



●     if you remove a portion of a cloud of points, the free edges of the remaining portion are 
displayed.

●     If you move a cloud of points or a mesh, its graphic display options (not the graphic 
properties) are lost.

●     The display options are not saved in the CATPart while the graphic properties are.

Edit/Properties menu (Graphic tab) 

For more information about this menu, please refer to the Displaying and Editing Graphic 
Properties  chapter in the CATIA Infrastructure user's guide.

The images below are only examples.



You can access this menu through Edit/Properties, or through the contextual menu of the 
element, or display the Graphic Properties toolbar (View/Toolbars/Graphic Properties). 

 

or



●     The color displayed in the Graphic Properties toolbar applies to meshes only.

●     The graphic properties are saved in the CATPart.

●     Use Fill/Color and Transparency to modify the color and transparency of meshs:

 

 

Please note that : 
●     the color of mesh free edges is yellow, and is not editable,

●     the color of non-manifold edges is white, and is not editable,

●     the default color of scans has changed to cyan.

For a higher transparency quality, go to Tools/Options/Display/Performances and check the 
High (Alpha blending) option.



●     Use Edges/Color, Line type and Thickness to modify the display of scans and grids or of 
the triangles of a mesh :

●     Use Points/Color and Symbol to modify the display of clouds of points:

 

●     Use the Pickable check box to make an element pickable or not, and choose the pick option 
in the list below.



Analyzing Using Highlights 
This task shows how to perform an analysis of the surfaces quality of shaded highlights.
It analyses the angle between surface normals and a predefined direction. Dependent on the 
angle, it sets the color at this surface position. All positions with the same angle between 
surface normal and predefined direction get the same shading color. If the angle is 90 degrees, 
the resulting stripe is the silhouette line related to the predefined direction.

Open the FreeStyle_13.CATPart document.

Make sure the Material visualization option is active in the View -> Render Style -> 

Customize View command to be able to see the analysis results on the selected element. 

Otherwise a warning is issued.

1.  Click the Highlight icon .

The Highlights dialog box opens.

 

You do not need to select the part in the specification tree as the analysis works globally on the 
part.

2.  Define the display options:
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●     Grid: two predefined directions define a grid of stripes (not necessarily perpendicular) on 

the surface. The plane tool u and v direction, are used as predefined directions in grid 

mode. If you uncheck the Grid options, it switches to the Stripes mode: the plane tool 

normal is the predefined direction.

●     Angle: highlights are distributed per angle

●     Global: the whole part is highlighted

 
●     Light Source Manipulation: opens the Light Source Manipulation dialog box to let you 

manipulate light sources

●     Anti-aliasing: stripes appear smoother

 

 
●     Density: defines the number of stripes or grid lines.

●     Thickness: defines the thickness of stripes or grid lines. 

●     Sharpness: defines the sharpness of stripes or grid lines (soft or hard color transition). 



Above is an example with the following values:
Grid and Global
Density=50
Thickness=0.30
Sharpness=0.80

 

 Above is an example with the following values:
Grid and Global
Density=80
Thickness=0.70
Sharpness=0.30



Above is an example with the following values:
Grid, Global, and Angle
Density=80
Thickness=0.70
Sharpness=0.30

 

 Above is an example with the following values:
Global and Angle
Density=80
Thickness=0.70
Sharpness=0.30

3.  Right-click the plane tool to display the Highlights Properties.



 
●     Define the snap mode to snap tool position and optionally orientation on geometry

❍     Off: no snap mode

❍     Vertex: the plane tool snaps on a vertex. Dependent on the vertex (surface corner, 3D 

curve endpoint), the direction is adapted to the surface normal or curve tangent 

❍     Curve: the plane tool snaps on a curve or surface edge. As a result in stripes mode the 

silhouette line of the plane tool normal crosses the edge at the plane tool origin

❍     Surface: the plane tool snaps on a surface and adapts the surface normal. As a result in 

grid mode the silhouette line of the plane tool u direction and the silhouette line of the 

plane tool v direction are crossing at the plane tool origin 

●     Define the rotation mode of the 3D tool: 

❍     Dynamic: normal dynamic rotation mode

❍     Discrete: the rotation of the tool snaps to certain relative grid angles.

❍     Grid: the rotation of the tool snaps to certain absolute grid angles.

❍     Static: the rotation is activated by a mouse click on the corresponding rotation handle 

of the tool. The grid value defines the specific rotation angle

●     Define the rotation value by entering a value or using the spinners

●     Define the numerical feedback of the 3D tool: 

❍     Distance 3D: direct distance between the start position of the translation and the 

current position

❍     Distance XYZ: distance shown in x, y and z components of the current coordinate 

system



❍     Coordinates: absolute position of the tool in the model coordinate system

 

 
4.  Click OK to create the analysis.

The analysis is displayed under the specification tree only when performing an analysis in the 
Automotive Class A workbench. 

For further information, please refer to the CATIA Automotive Class A documentation.



Analyzing Using Curvature

This task shows how to analyze the mapping curvature of a surface.

 The Curvature command shows the curvature of the polygonal mesh in the form of a color map 
on the mesh. Gaussian and Mean curvature will be available. 

Open the CurvatureAnalysis1.CATPart document.

 
●     The discretization option should be set to a maximum: in Tools -> Options -> Display -> 

Performances, set the 3D Accuracy -> Fixed option to 0.01.

●     Check the Material option in the View -> Render Style -> Customize View command to 
be able to see the analysis results on the selected element.

1.  Click the Display Curvature icon .

The Curvature dialog box is displayed.

2.  Define the curvature colors using the combo list.

3.  Set the mapping type:

❍     Mean

❍     Gaussian (as in our example)

4.  Set the color scale:
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❍     Linear

❍     Log (logarithmic)

5.  Define the color position and range by manipulating directly the color scale in the dialog 

box.

6.  Select the polygonal mesh.

7.  Click Apply to visualize the result of the analysis.

8.  Click OK to exit the command.



Interoperability with Wireframe
Creating Points
Creating Lines
Creating Planes
Creating Circles
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Creating Points

 

This task shows the various methods for creating points: 
●     by coordinates

●     on a curve

●     on a plane

●     on a surface

●     at a circle/sphere center

●     tangent point on a curve

●     between

 
Open the Points3D1.CATPart document.

 
1.  Click the Point icon  .

The Point Definition dialog box appears.

2.  Use the combo to choose the desired point type.

 

Coordinates 
 

http://arbre2dsy/spuCXR15/Doc/online/cfysm_C2/samples/Points3D1.CATPart


●     Enter the X, Y, Z coordinates in the current axis-system.

●     Optionally, select a Reference Point.

The corresponding point is displayed.

●     When the command is launched at creation, the initial value in the Axis System field is the 
current local axis system. If no local axis system is current, the field is set to Default. 
Whenever you select a local axis system, the point's coordinates are changed with respect 
to the selected axis system so that the location of the point is not changed. This is not the 
case with points valuated by formulas: if you select an axis system, the defined formula 
remains unchanged.
This option replaces the Coordinates in absolute axis-system option.

 

If you create a point using the coordinates method and an axis system is already defined and 
set as current, the point's coordinates are defined according to current the axis system. As a 
consequence, the point's coordinates are not displayed in the specification tree.

The current local axis system must be different from the absolute axis.

 

On curve 
 



●     Select a curve

●     Optionally, select a reference point.

If this point is not on the curve, it is projected onto the curve.
If no point is selected, the curve's extremity is used as reference.

●     Select an option point to determine whether the new point is to be created: 
❍     at a given distance along the curve from the reference point

❍     a given ratio between the reference point and the curve's extremity.

    

●     Enter the distance or ratio value.
If a distance is specified, it can be: 

❍     a geodesic distance: the distance is measured along the curve

❍     an Euclidean distance: the distance is measured in relation to the reference point 
(absolute value).

The corresponding point is displayed.

 

It is not possible to create a point with an euclidean distance if the distance or the ratio value is 
defined outside the curve.

You can also: 
●     click the Nearest extremity button to display the point at the nearest extremity of the 

curve.

●     click the Middle Point button to display the mid-point of the curve.



Be careful that the arrow is orientated towards the inside of the curve (providing the curve is 
not closed) when using the Middle Point option.

●     use the Reverse Direction button to display: 
❍     the point on the other side of the reference point (if a point was selected originally)

❍     the point from the other extremity  (if no point was selected originally).

●     click the Repeat object after OK if you wish to create equidistant points on the curve, 
using the currently created point as the reference, as described in Creating Multiple Points 
in the Wireframe and Surface User's Guide. 

You will also be able to create planes normal to the curve at these points, by 
checking the Create normal planes also button, and to create all instances in a 
new geometrical set  by checking the Create in a new geometrical set button.
If the button is not checked the instances are created in the current geometrical set.

 

 

●     If the curve is infinite and no reference point is explicitly given, by default, the reference 
point is the projection of the model's origin

●     If the curve is a closed curve, either the system detects a vertex on the curve that can be 
used as a reference point, or it creates an extremum point, and highlights it (you can then 
select another one if you wish) or the system prompts you to manually select a reference 
point.

 Extremum points created on a closed curve are aggregated under their parent command and 
put in no show in the specification tree.

 



 

●     Select a plane.
❍     If you select one of the planes of any local axis system as the plane, the origin of this 

axis system is set as the reference point and featurized. If you modify the origin of the 
axis system, the reference point is modified accordingly.

●     Optionally, select a point to define a reference for computing coordinates in the plane.
❍     If no point is selected, the projection of the model's origin on the plane is taken as 

reference.

●     Optionally, select a surface on which the point is projected normally to the plane.
❍     If no surface is selected, the behavior is the same.

Furthermore, the reference direction (H and V vectors) is computed as follows: 
With N the normal to the selected plane (reference plane), H results from the 
vectorial product of Z and N (H = Z^N). 
If the norm of H is strictly positive then V results from the vectorial product of N and 
H (V = N^H).
Otherwise, V = N^X and H = V^N.

Would the plane move, during an update for example, the reference direction would 
then be projected on the plane. 

●     Click in the plane to display a point.

 
On plane 



 

 

On surface 
 

●     Select the surface where the point is to be created.

●     Optionally, select a reference point. By default, the surface's middle point is taken as 
reference. 

●     You can select an element to take its orientation as reference direction or a plane to take 
its normal as reference direction.
You can also use the contextual menu to specify the X, Y, Z components of the reference 
direction.

●     Enter a distance along the reference direction to display a point.



●     Choose the dynamic positioning of the point:

❍     Coarse (default behavior): the distance computed between the reference point and the 

mouse click is an euclidean distance. Therefore the created point may not be located at 

the location of the mouse click (see picture below).

The manipulator (symbolized by a red cross) is continually updated as you move the 

mouse over the surface.

 

❍     Fine: the distance computed between the reference point and the mouse click is a 

geodesic distance. Therefore the created point is located precisely at the location of the 

mouse click.

The manipulator is not updated as you move the mouse over the surface, only when 

you click on the surface.



Sometimes, the geodesic distance computation fails. In this case, an euclidean distance might 
be used and the created point might not be located at the location of the mouse click. This is 
the case with closed surfaces or surfaces with holes. We advise you to split these surfaces 
before creating the point.

 
Circle/Sphere center 

 

●     Select a circle, circular arc, or ellipse, or

●     Select a sphere or a portion of sphere.

 

A point is displayed at the center of the selected element.

 
Tangent on curve 

 



●     Select a planar curve and a direction line.

A point is displayed at each tangent. 

The Multi-Result Management dialog box is displayed because several points are 
generated. Refer to the Managing Multi-Result Operations chapter.

 

 

Between
 

●     Select any two points.

 

●     Enter the ratio, that is the percentage of the distance from the first selected point, at which 
the new point is to be.
You can also click Middle Point button to create a point at the exact midpoint (ratio = 
0.5).

http://arbre2dsy/spuCXR15/Doc/online/cfyug_C2/cfyugmultiresult.htm


Be careful that the arrow is orientated towards the inside of the curve (providing the curve is 
not closed) when using the Middle Point option.

●     Use the Reverse direction button to measure the ratio from the second selected point.

 

 
If the ratio value is greater than 1, the point is located on the virtual line beyond the selected 
points.

3.  Click OK to create the point.

The point (identified as Point.xxx) is added to the specification tree.

●     Parameters can be edited in the 3D geometry. For more information, refer to the Editing 
Parameters chapter.

●     You can isolate a point in order to cut the links it has with the geometry used to create it. 
To do so, use the Isolate contextual menu. For more information, refer to the Isolating 
Geometric Elements chapter.
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Creating Lines
This task shows the various methods for creating lines: 

●     point to point

●     point and direction

●     angle or normal to curve

●     tangent to curve

●     normal to surface

●     bisecting

 
It also shows you how to create a line up to an element, define the length type and automatically reselect 
the second point.

 
Open the Lines1.CATPart document.

1.  Click the Line icon  .

The Line Definition dialog box is displayed. 

2.  Use the drop-down list to choose the desired line type.

 
A line type will be proposed automatically in some cases depending on your first element selection.

 

Defining the line type
 

Point - Point 

This type is only available with the Generative Shape Design 2 product.

 

http://arbre2dsy/spuCXR15/Doc/online/cfysm_C2/samples/Lines1.CATPart


 ●     Select two points.

 A line is displayed between the two points.
Proposed Start and End points of the new line are shown.

 

 
●     If needed, select a support surface.

In this case a geodesic line is created, i.e. going from one point to the other according to the shortest 
distance along the surface geometry (blue line in the illustration below).
If no surface is selected, the line is created between the two points based on the shortest distance.

If you select two points on closed surface (a cylinder for example), the result may be unstable. Therefore, 
it is advised to split the surface and only keep the part on which the geodesic line will lie. 

 
The geodesic line is not available with the Wireframe and Surface workbench.



 
●     Specify the Start and End points of the new line, that is the line endpoint location in relation to the 

points initially selected. These Start and End points are necessarily beyond the selected points, 
meaning the line cannot be shorter than the distance between the initial points.

●     Check the Mirrored extent option to create a line symmetrically in relation to the selected Start and 
End points.

 
The projections of the 3D point(s) must already exist on the selected support. 

 
Point - Direction 

 



●     Select a reference Point and a Direction line.
A vector parallel to the direction line is displayed at the reference point. 
Proposed Start and End points of the new line are shown.

 

●     Specify the Start and End points of the new line.
The corresponding line is displayed.

 
The projections of the 3D point(s) must already exist on the selected support. 

 
Angle or Normal to curve 



 

 

●     Select a reference Curve and a Support surface containing that curve.
❍     If the selected curve is planar, then the Support is set to Default (Plane).

❍     If an explicit Support has been defined, a contextual menu is available to clear the selection.

●     Select a Point on the curve.

●     Enter an Angle value.

 



 A line is displayed at the given angle with respect to the tangent to the reference curve at the selected 
point. These elements are displayed in the plane tangent to the surface at the selected point. 
You can click on the Normal to Curve button to specify an angle of 90 degrees. 
Proposed Start and End points of the line are shown. 

 
●     Specify the Start and End points of the new line.

The corresponding line is displayed.

 
●     Click the Repeat object after OK if you wish to create more lines with the same definition as the 

currently created line. 
In this case, the Object Repetition dialog box is displayed, and you key in the number of instances to 
be created before pressing OK.

 

 As many lines as indicated in the dialog box are created, each separated from the initial line by a multiple 
of the angle value.

You can select the Geometry on Support check box if you want to create a geodesic line onto a support 

surface. 

The figure below illustrates this case.



 

Geometry on support option not checked Geometry on support option checked

 
This line type enables to edit the line's parameters. Refer to Editing Parameters to find out how to display 
these parameters in the 3D geometry.

 
Tangent to curve 
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●     Select a reference Curve and a point or another Curve to define the tangency. 
❍     if a point is selected (mono-tangent mode): a vector tangent to the curve is displayed at 

the selected point.

❍     If a second curve is selected (or a point in bi-tangent mode), you need to select a support plane. 
The line will be tangent to both curves.

■     If the selected curve is a line, then the Support is set to Default (Plane).

■     If an explicit Support has been defined, a contextual menu is available to clear the selection.

 When several solutions are possible, you can choose one (displayed in red) directly in the geometry, or 
using the Next Solution button.

 

 

Line tangent to curve at a given point Line tangent to two curves

●     Specify Start and End points to define the new line.
The corresponding line is displayed.



 

 
●     Select a reference Surface and a Point.

A vector normal to the surface is displayed at the reference point. 
Proposed Start and End points of the new line are shown.

 

 If the point does not lie on the support surface, the minimum distance between the point and the surface 
is computed, and the vector normal to the surface is displayed at the resulted reference point.

●     Specify Start and End points to define the new line.
The corresponding line is displayed.

 

 
Normal to surface 



 
Bisecting 

 



●     Select two lines. Their bisecting line is the line splitting in two equals parts the angle between these 
two lines. 

●     Select a point as the starting point for the line. By default it is the intersection of the bisecting line 
and the first selected line.

●     Select the support surface onto which the bisecting line is to be projected, if needed.

●     Specify the line's length by defining Start and End values (these values are based onto the default 
start and end points of the line).
The corresponding bisecting line, is displayed.

●     You can choose between two solutions, using the Next Solution button, or directly clicking the 
numbered arrows in the geometry.

 

3.  Click OK to create the line.

The line (identified as Line.xxx) is added to the specification tree.

●     Regardless of the line type, Start and End values are specified by entering distance values or by 
using the graphic manipulators.

●     Start and End values should not be the same.

●     Check the Mirrored extent option to create a line symmetrically in relation to the selected Start 
point. 
It is only available with the Length Length type.

●     In most cases, you can select a support on which the line is to be created. In this case, the selected 
point(s) is projected onto this support.

●     You can reverse the direction of the line by either clicking the displayed vector or selecting the 
Reverse Direction button (not available with the point-point line type).

●     Parameters can be edited in the 3D geometry. For more information, refer to the Editing Parameters 
chapter.

●     You can isolate a line in order to cut the links it has with the geometry used to create it. To do so, use 
the Isolate contextual menu. For more information, refer to the Isolating Geometric Elements 
chapter.
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Creating a line up to an element 
 This capability allows you to create a line up to a point, a curve, or a surface.

●     It is available with all line types, but the Tangent to curve type.

 
Up to a point

●     Select a point in the Up-to 1 and/or Up-to 2 fields.

Here is an example with the Bisecting line type, the Length Length type, and a point as Up-to 2 
element.

 

 
Up to a curve

●     Select a curve in the Up-to 1 and/or Up-to 2 fields.

Here is an example with the Point-Point line type, the Infinite End Length type, and a curve as the 
Up-to 1 element.



 

 
Up to a surface

●     Select a surface in the Up-to 1 and/or Up-to 2 fields.

Here is an example with the Point-Direction line type, the Length Length type, and the surface as the 
Up-to 2 element.

 

●     If the selected Up-to element does not intersect with the line being created, then an extrapolation is 
performed. It is only possible if the element is linear and lies on the same plane as the line being 
created.
However, no extrapolation is performed if the Up-to element is a curve or a surface.

●     The Up-to 1 and Up-to 2 fields are grayed out with the Infinite Length type, the Up-to 1 field is 
grayed out with the Infinite Start Length type, the Up-to 2 field is grayed out with the Infinite End 
Length type.

●     The Up-to 1 field is grayed out if the Mirrored extent option is checked.

●     In the case of the Point-Point line type, Start and End values cannot be negative.

 

Defining the length type



 
●     Select the Length Type: 

❍     Length: the line will be defined according to the Start and End points values

❍     Infinite: the line will be infinite

❍     Infinite Start Point: the line will be infinite from the Start point

❍     Infinite End Point: the line will be infinite from the End point

By default, the Length type is selected.
The Start and/or the End points values will be grayed out when one of the Infinite options is chosen.

 

Reselecting automatically a second point
This capability is only available with the Point-Point line method.

1.  Double-click the Line icon .

The Line dialog box is displayed.

2.  Create the first point.

 The Reselect Second Point at next start option appears in the Line dialog box.

3.  Check it to be able to later reuse the second point.

4.  Create the second point.

5.  Click OK to create the first line.

 

 The Line dialog box opens again with the first point initialized with the second point of the first 
line.

6.  Click OK to create the second line.



 

 To stop the repeat action, simply uncheck the option or click Cancel in the Line Definition dialog box.

 



Creating Planes

 
This task shows the various methods for creating planes:

 

●     offset from a plane

●     parallel through point

●     angle/normal to a plane

●     through three points

●     through two lines

●     through a point and a line

●     through a planar curve

●     normal to a curve

●     tangent to a surface

●     from its equation

●     equation

●     mean through points

 

 
Open the Planes1.CATPart document.

 
1.  Click the Plane icon  .

The Plane Definition dialog box appears.

2.  Use the combo to choose the desired Plane type.

 
Once you have defined the plane, it is represented by a red square symbol, which you can 
move using the graphic manipulator.

 
Offset from plane

 

●     Select a reference Plane then enter an Offset value.

A plane is displayed offset from the reference plane.

http://arbre2dsy/spuCXR15/Doc/online/cfysm_C2/samples/Planes1.CATPart


 

 Use the Reverse Direction button to  reverse the change the offset direction, or 
simply click on the arrow in the geometry.

 
●     Click the Repeat object after OK if you wish to create more offset planes. 

In this case, the Object Repetition dialog box is displayed, and you key in the number of 
instances to be created before pressing OK.

 

As many planes as indicated in the dialog box are created (including the one you 
were currently creating), each separated from the initial plane by a multiple of the 
Offset value. 

 



 

●     Select a reference Plane and a Point.

 

A plane is displayed parallel to the reference plane and passing through the selected 
point.

 
Parallel through point 



 

●     Select a reference Plane and a Rotation axis.
This axis can be any line or an implicit element, such as a cylinder axis for 
example. To select the latter press and hold the Shift key while moving the 
pointer over the element, then click it.

●     Enter an Angle value.

 

The plane is displayed such as its center corresponds to the projection of the center 
of the reference plane on the rotation axis. It is oriented at the specified angle to the 
reference plane. 

●     Check the Project rotation axis on reference plane option if you wish to project the 
rotation axis onto the reference plane. If the reference plane is not parallel to the rotation 
axis, the created plane is rotated around the axis to have the appropriate angle with regard 
to reference plane.

●     Check the Repeat object after OK option if you wish to create more planes at an angle 
from the initial plane. 
In this case, the Object Repetition dialog box is displayed, and you key in the number of 
instances to be created before pressing OK.

 
Angle or normal to plane 



 

As many planes as indicated in the dialog box are created (including the one you 
were currently creating), each separated from the initial plane by a multiple of the 
Angle value.

Here we created five planes at an angle of 20 degrees.

 

 This plane type enables to edit the plane's parameters. Refer to Editing Parameters to find out 
how to display these parameters in the 3D geometry.

 

Through three points 
 

●     Select three points.
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The plane passing through the three points is displayed. You can move it simply by 
dragging it to the desired location.

 

Through two lines 
 

●     Select two lines.



The plane passing through the two line directions is displayed.
When these two lines are not coplanar, the vector of the second line is moved to the 
first line location to define the plane's second direction. 

 

Check the Forbid non coplanar lines button to specify that both lines be in the same plane.



 

●     Select a Point and a Line.

 

The plane passing through the point and the line is displayed. 

 

Through point and line 



 

●     Select a planar Curve.

 

The plane containing the curve is displayed.

 

Through planar curve 



 

●     Select a reference Curve.

●     You can select a Point. By default, the curve's middle point is selected.

It can be selected outside the curve.

 

A plane is displayed normal to the curve with its origin at the specified point. The 
normal is computed at the point on the curve that is the nearest to the selected 
point.

 
Normal to curve 



 

Tangent to surface 
 

 
●     Select a reference Surface and a Point.

 

A plane is displayed tangent to the surface at the specified point.  



 
Equation 

 

●     Enter the A, B, C, D components of the Ax + By + Cz = D plane equation.



●     Select a point to position the plane through this point, you are able to modify A, 
B, and C components, the D component becomes grayed.

●     When the command is launched at creation, the initial value in the Axis System 
field is the current local axis system. If no local axis system is current, the field is 
set to Default. 
Whenever you select a local axis system, A, B, C, and D values are changed with 
respect to the selected axis system so that the location of the plane is not 
changed. This is not the case with values valuated by formulas: if you select an 
axis system, the defined formula remains unchanged.
This option replaces the Coordinates in absolute axis-system option.

 Use the Normal to compass button to position the plane perpendicular to the compass 
direction.

 

 
Use the Parallel to screen button to parallel to the screen current view.

 



 

●     Select three or more points to display the mean plane through these points.

 

It is possible to edit the plane by first selecting a point in the dialog box list then 
choosing an option to either:

●     Remove the selected point

●     Replace the selected point by another point.

3.  Click OK to create the plane.

The plane (identified as Plane.xxx) is added to the specification tree.
  

 

Mean through points 



●     Parameters can be edited in the 3D geometry. For more information, refer to the Editing 
Parameters chapter.

●     You can isolate a plane in order to cut the links it has with the geometry used to create it. 
To do so, use the Isolate contextual menu. For more information, refer to the Isolating 
Geometric Elements chapter.
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Creating Circles

 

This task shows the various methods for creating circles and circular arcs: 

●     center and radius

●     center and point

●     two points and radius

●     three points

●     center and axis

●     bitangent and radius

●     bitangent and point

●     tritangent

●     center and tangent

 

Open the Circles1.CATPart document.
Please note that you need to put the desired geometrical set in show to be able to perform the corresponding scenario. 

 
1.  Click the Circle icon .

The Circle Definition dialog box appears. 

2.  Use the drop-down list to choose the desired circle type.

 
Center and radius 

 

 
●     Select a point as circle Center.

●     Select the Support plane or surface where the circle is to be created.

●     Enter a Radius value.

Depending on the active Circle Limitations icon, the corresponding circle or circular arc is displayed.
For a circular arc, you can specify the Start and End angles of the arc.

file:///E|/www/spuCXR15/CfySamples/cfysm.doc/src/samples/Circles1.CATPart


 

 

●     If a support surface is selected, the circle lies on the plane tangent to the surface at the selected point.

●     Start and End angles can be specified by entering values or by using the graphic manipulators.

 
Center and point 

 

●     Select a point as Circle center.

●     Select a Point where the circle is to be created.

●     Select the Support plane or surface where the circle is to be created.

The circle, which center is the first selected point and passing through the second point or the projection of this second point 
on the plane tangent to the surface at the first point, is previewed. 

Depending on the active Circle Limitations icon, the corresponding circle or circular arc is displayed.
For a circular arc, you can specify the Start and End angles of the arc.

 



 
Two points and radius     

 

 
●     Select two points on a surface or in the same plane.

●     Select the Support plane or surface.
 

You can now select a direction as the support. The support is calculated using this direction and the two input points. The 
plane passing through the two points and whose normal is closest to the given direction is computed as follows:

●     Let's take V1 as the vector P1P2, where P1 and P2 are the input points.

●     Let's take V2 as the user direction (which can be the compass direction).

●     Compute V3 = V1 X V2 (cross product).

●     Compute V4 = V3 X V1 (cross product).

●     The support plane is normal to V4 and passing through P1 and P2.

●     Note that if V2 is orthogonal to V1, V4 = V2 and the support plane is normal to V2 (user direction).

●     Enter a Radius value.

The circle, passing through the first selected point and the second point or the projection of this second point on the plane 
tangent to the surface at the first point, is previewed. 

Depending on the active Circle Limitations icon, the corresponding circle or circular arc is displayed. 
For a circular arc, you can specify the trimmed or complementary arc using the two selected points as end points. 

You can use the Second Solution button, to display the alternative arc.
 

 With a plane as Support With a direction as Support (the computed plane is 
shown in blue)



 
Three points 

 

●     Select three points where the circle is to be created.

Depending on the active Circle Limitations icon, the corresponding circle or circular arc is displayed. 
For a circular arc, you can specify the trimmed or complementary arc using the two of the selected points as end points.

 

 
Center and axis  

 



 
●     Select the axis/line.

It can be any linear curve.

●     Select a point.

●     Enter a Radius value.

●     Set the Project point on axis/line option:
❍     checked (with projection): the circle is centered on the reference point and projected onto the input axis/line and lies 

in the plane normal to the axis/line passing through the reference point. The line will be extended to get the 
projection if required.

❍     unchecked (without projection): the circle is centered on the reference point and lies in the plane normal to the 
axis/line passing though the reference point.

 

 With projection Without projection

 
Bi-tangent and radius 

 

●     Select two Elements (point or curve) to which the circle is to be tangent.

●     Select a Support surface.

 If one of the selected inputs is a planar curve, then the Support is set to Default (Plane).
If an explicit Support needs to be defined, a contextual menu is available to clear the selection in order to select the desired 
support.

This automatic support definition saves you from performing useless selections.



 
●     Enter a Radius value.

●     Several solutions may be possible, so click in the region where you want the circle to be.

Depending on the active Circle Limitations icon, the corresponding circle or circular arc is displayed. 
For a circular arc, you can specify the trimmed or complementary arc using the two tangent points as end points. 

 

 You can select the Trim Element 1 and Trim Element 2 check boxes to trim the first element or the second element, or 
both elements.
Here is an example with Element 1 trimmed.

 

These options are only available with the Trimmed Circle limitation.

 
Bi-tangent and point 

 



●     Select a point or a curve to which the circle is to be tangent.

●     Select a Curve and a Point on this curve.

●     Select a Support plane or planar surface.

The point will be projected onto the curve.

 If one of the selected inputs is a planar curve, then the Support is set to Default (Plane).
If an explicit Support needs to be defined, a contextual menu is available to clear the selection in order to select the desired 
support.

This automatic support definition saves you from performing useless selections.

 

●     Several solutions may be possible, so click in the region where you want the circle to be.

Depending on the active Circle Limitations icon, the corresponding circle or circular arc is displayed. 

Complete circle

For a circular arc, you can choose the trimmed or complementary arc using the two tangent points as end points.

Trimmed circle Complementary trimmed circle

 You can select the Trim Element 1 and Trim Element 2 check boxes to trim the first element or the second element, or 
both elements.
Here is an example with both elements trimmed.

 

These options are only available with the Trimmed Circle limitation.  

 
Tritangent 



 

●     Select three Elements to which the circle is to be tangent.

●     Select a Support planar surface.

 If one of the selected inputs is a planar curve, then the Support is set to Default (Plane).
If an explicit Support needs to be defined, a contextual menu is available to clear the selection in order to select the desired 
support.

This automatic support definition saves you from performing useless selections.

 
●     Several solutions may be possible, so select the arc of circle that you wish to create.

Depending on the active Circle Limitations icon, the corresponding circle or circular arc is displayed. The first and third 
elements define where the relimitation ends. 
For a circular arc, you can specify the trimmed or complementary arc using the two tangent points as end points.

 

 You can select the Trim Element 1 and Trim Element 3 check boxes to trim the first element or the third element, or both 
elements.
Here is an example with Element 3 trimmed.

 



These options are only available with the Trimmed Circle limitation.

You cannot create a tritangent circle if an input point lies on an input wire. We advise you to use the bi-tangent and point 
circle type.

 
Center and tangent 

 

 There are two ways to create a center and tangent circle:
 1.  Center curve and radius

●     Select a curve as the Center Element.

●     Select a Tangent Curve.

●     Enter a Radius value.

 

 2.  Line tangent to curve definition

●     Select a point as the Center Element.

●     Select a Tangent Curve.



 

●     If one of the selected inputs is a planar curve, then the Support is set to Default (Plane).
If an explicit Support needs to be defined, a contextual menu is available to clear the selection in order to select the 
desired support.

This automatic support definition saves you from performing useless selections.

●     The circle center will be located either on the center curve or point and will be tangent to tangent curve.

●     Note that only full circles can be created.

4.  Click OK to create the circle or circular arc.

The circle (identified as Circle.xxx) is added to the specification tree.
  

●     You can click the Diameter button to switch to a Diameter value. Conversely, click the Radius button to switch back to 
the Radius value. 
This option is available with the Center and radius, Two point and radius, Bi-tangent and radius, Center and 
tangent, and Center and axis circle types.

Note that the value does not change when switching from Radius to Diameter and vice-versa.

 
●     You can select the Axis computation check box to automatically create axes while creating or modifying a circle. Once 

the option is checked, the Axis direction field is enabled. 

❍     If you do not select a direction, an axis normal to the circle will be created.

❍     If you select a direction, two more axes features will be created: an axis aligned with the reference direction and an 

axis normal to the reference direction.

In the specification tree, the axes are aggregated under the Circle feature. You can edit their directions but cannot modify 

them.

If the datum mode is active, the axes are not aggregated under the Circle features, but one ore three datum lines are 

created.

 



 Axis normal to the circle

 

 Axis aligned with the reference direction
(yz plane)

 

 Axis normal to the reference direction
(yz plane) 

●     If you select the Geometry on Support option and the selected support is not planar, then the Axis Computation is not 

possible.

 
●     You can select the Geometry on Support check box if you want the circle to be projected onto a support surface.

In this case just select a support surface.

This option is available with the Center and radius, Center and point, Two point and radius, and Three points 

circle types.

 
●     When several solutions are possible, click the Next Solution button to move to another arc of circle, or directly select 

the arc you want in the 3D geometry.

●     A circle may have several points as center if the selected element is made of various circle arcs with different centers.

  
●     Parameters can be edited in the 3D geometry. For more information, refer to the Editing Parameters chapter.

●     You can isolate a plane in order to cut the links it has with the geometry used to create it. To do so, use the Isolate 
contextual menu. For more information, refer to the Isolating Features chapter.

 

file:///E|/www/spuCXR15/CfyEnglish/cfyug.doc/src/cfyugparameters.htm
file:///E|/www/spuCXR15/CfyEnglish/cfyug.doc/src/cfyugisolate.htm


Generic Tools
Managing the Compass

http://arbre2dsy/spuCXR15/Doc/online/cfyugfss_C2/cfyugfssut0101.htm


Managing the Compass 

This task shows you how to quickly manage the compass orientation.

Create a planar surface.

1.  Click the Quick Compass Orientation icon:  

 The Quick compass orientation toolbar is displayed.

 

This toolbar can be displayed using the F5 key.
This shortcut is effective only when the Quick compass orientation toolbar is 
displayed. Therefore when you first hit this key, the toolbar is displayed and the 
shortcut is effective from then on.

 

●      Flip to UV or XY.

●      Flip to VW or YZ.

●      Flip to WU or XZ.

●      Most Seen Plane.

●      Set Compass Orientation.

●      Reset Compass to XYZ.

●      In Model or on Perch.

●      Create Compass Plane.



●     If the compass axes correspond to the main axes of the model, the axe names 
indicate X, Y and Z otherwise X|U, Y|V and Z|W.

●     By default, elements are created in the current active plane as defined using the 

Current plane orientation toolbar containing the Flip to UV or XY , Flip 

to VW or YZ   or Flip to WU or XZ  icons.

●     The Quick compass orientation toolbar remains active until you close it by 
clicking the cross in the upper-right corner or, if you have activated it with the 
icon, by clicking the icon again.

 

Flip to UV or XY
 This option switch the compass base to the UV or XY plane of its trihedron.

 

Flip to VW or YZ
 This option switch the compass base to the VW or YZ plane of its trihedron.

 

Flip to WU or XZ
 This option switch the compass base to the WU or XZ plane of its trihedron.

 

Most Seen Plane
 This option allows you to set the compass according to the plane whose normal is 

closest to the screen normal.

 

Set Compass Orientation

●     This option allows you to orientate the compass by selecting either an existing 
plane or three points (via the Autodetection command).
The point selection is based on Autodetection parameters.

●     This option can be also activated using the F6 key.
This shortcut is effective only when the Quick compass orientation toolbar is 
displayed. Therefore when you first hit this key, the toolbar is displayed and the 
shortcut is effective from then on.

Refer to Editing Curves Using Control Points to orientate the compass using control 
points.

file:///E|/www/spuCXR15/CfyEnglish/cfyugfss.doc/src/cfyugfssut0201.htm


 

Reset Compass to XYZ

●     This option allows you to reset the compass parallel to the main axes (X, Y and 
Z) of the model.
This option is deactivated when the compass is already set according to the 
axes.

●     This option can be also activated using the F7 key.
This shortcut is effective only when the Quick compass orientation toolbar is 
displayed. Therefore when you first hit this key, the toolbar is displayed and the 
shortcut is effective from then on.

 In Model or on Perch
This option allows you to switch the compass from the perch to the model or vice 
versa.
The origin is kept in the model until the toolbar remains open.

 

Create Compass Plane

●     This option allows you to drop the compass plane, that is to create a plane 
corresponding to the compass basis.
This option is activated only when the compass is in the model.

●     This option can be also activated using the F8 key.
This shortcut is effective only when the Quick compass orientation toolbar is 
displayed. Therefore when you first hit this key, the toolbar is displayed and the 
shortcut is effective from then on.



Shape Sculptor Interoperability
Optimal CATIA PLM Usability for Shape Sculptor



Optimal CATIA PLM Usability for Shape 
Sculptor

When working with ENOVIA V5, the safe save mode ensures that you only create data in CATIA 
that can be correctly saved in ENOVIA. 
ENOVIA V5 offers two different storage modes: Workpackage (Document kept - Publications 
Exposed) and Explode (Document not kept). 

 In Shape Sculptor workbench, when saving data into ENOVIA V5, the global transaction is 
guaranteed (both in Workpackage and Explode modes). All Shape Sculptor commands are thus 
available at all times.

To ensure seamless integration, you must have both a CATIA and ENOVIA session running.

For more information on the Safe Save mode, refer to "How to do a Safe Save in ENOVIA LCA 
from CATIA V5" in the Version 5 ENOVIA-CATIA Interoperability User's Guide.

 



Workbench Description
This section contains the description of the icons, menus and Historical Graph that are specific to the CATIA - Shape 
Sculptor workbench, which is shown below. 

You can click the hotspots on this image to see the related documentation.

Menu Bar
Input / Output Toolbar

Component Selection Toolbar
Creation Toolbar
Editing Toolbar

Modeling Toolbar
Analysis Toolbar

Wireframe Toolbar
Compass Toolbar



Menu Bar
This section presents the tools and commands which are available in the Shape Sculptor workbench. 
Many other operations are documented in the Infrastructure User's Guide.

Start File Edit View Insert Tools Window Help

File

The File menu lets you perform file creation, opening saving, printing operations 

Edit 

The Edit menu lets you manipulate selected objects. Refer to the Infrastructure User's Guide and Part 
Design User's Guide. 

View 

The View menu lets you view document contents  Refer to the Infrastructure User's Guide.

Insert 

The Insert menu lets you insert Shape Sculptor's elements.

 For... See...

     

Geometrical 
set...

Managing Geometrical Sets

Input/Output Insert -> Input/Output

Component 
Selection 

Insert -> Component Selection

Creation Insert -> Creation

Editing Insert -> Editing

Modeling Insert -> Modeling

Analysis Insert -> Analysis

Wireframe Insert -> Wireframe

http://arbre2dsy/spuCXR15/Doc/online/basug_C2/basugwd0100.htm
http://arbre2dsy/spuCXR15/Doc/online/basug_C2/basugwd0100.htm
http://arbre2dsy/spuCXR15/Doc/online/cfyug_C2/cfyuggeomsets.htm


Insert -> Input/Output
 For... See...

Import... Importing Files

Export... Exporting to STL

Insert -> Component Selection
 For... See...

Brush Select...Selecting With a Brush

Box Trap Selecting With a Box Trap

Curve Select Selecting With Curves

Hole Select Selecting Holes

Flood Select Selecting With Flood

Invert Select Inverting the Selection

Activate Selecting Using the Activate Command

Activate All Selecting Using the Activate All Command

Insert -> Creation
 For... See...

Create Curve... Creating 3D Curves

Paint Curve Creating Paint Curves

Generate 
Mesh...

Generating Meshes

Tessellate... Tessellating

Rough Offset...Creating a Rough Offset

Insert -> Editing
 For... See...

Decimate... Decimating

Refine... Refining

Smooth... Smoothing

Brush 
Smooth...

Smoothing With a Brush

Delete 
Triangles

Deleting Triangles



Extract 
Triangles

Extracting Triangles

Copy Triangles Copying Triangles

Slice... Slicing

Trim/Split Trim/Split

Mesh 
Intersect...

Intersecting Meshes

Stitch... Stitching

Insert -> Modeling
 For... See...

Edit Control 
Points...

Editing Curves Using Control Points

Project 
Curve...

Projecting Curves

Curve 
Sculpt...

Sculpting Curves

Emboss... Embossing

Push/Pull... Pushing / Pulling a Mesh

Surface 
Sculpt...

Sculpting With Surfaces

Sharp Edge Creating Sharp Edges

Grid 
Modeling...

Modeling Using a Grid

Interactive 
Grid 
Modeling...

Modeling Using an Interactive Grid

Insert -> Analysis
 For... See...

Display 
Options...

Display Options and Graphic Properties

Highlight Analyzing Using Highlights

Display 
Curvature...

Analyzing Using Curvature

Insert -> Wireframe

http://arbre2dsy/spuCXR15/Doc/online/cfyugrvs_C2/cfyugmeshstrimsplit.htm
http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/dssugbt0530.htm
http://arbre2dsy/spuCXR15/Doc/online/cfyugfss_C2/cfyugfssut0307.htm


For... See...

Point... Creating Points

Line... Creating Lines

Plane... Creating Planes

Circle... Creating Circles

Window 

The Window  menu lets you arrange document windows in relation one to the other. Refer to the 
Infrastructure User's Guide. 

Help 

The Help menu lets you get help on the currently active command, and the product in general. Refer 
to the Infrastructure User's Guide. 

http://arbre2dsy/spuCXR15/Doc/online/cfyug_C2/cfyugcircle3D.htm
http://arbre2dsy/spuCXR15/Doc/online/basug_C2/basugwd0100.htm
http://arbre2dsy/spuCXR15/Doc/online/basug_C2/basugwd0100.htm


Input / Output Toolbar
This toolbar contains the following tools to manage the import and export of polygonal meshes.

  

 

See Importing 
Files

See Exporting 
to STL



Component Selection Toolbar
This toolbar contains the following tools to manage the selection of triangles on the polygonal mesh.

  

 

See Selecting With a 
Brush

See Selecting With a Box 
Trap

See Selecting With 
Curves

See Selecting Holes

See Selecting With Flood

See Inverting the 
Selection

See Selecting Using the 
Activate Command

See Selecting Using the 
Activate All Command



Creation Toolbar
This toolbar contains the following tools to manage the creation of curves and polygonal meshes.

  

 

See Creating 
3D Curves

See Creating 
Paint Curves

See 
Generating 
Meshes

See 
Tessellating

See Creating a 
Rough Offset



Editing Toolbar
This toolbar contains the following tools to manage the operations that can be performed on a 
polygonal mesh.

  

 

See 
Decimating

See Refining

See 
Smoothing

See 
Smoothing 
Using a Brush

See Deleting 
Triangles

See Extracting 
Triangles

See Copying 
Triangles

See Slicing

See 
Intersecting 
Meshes

See Trim/Split

See Stitching

http://arbre2dsy/spuCXR15/Doc/online/cfyugrvs_C2/cfyugmeshstrimsplit.htm


Modeling Toolbar
This toolbar contains the following tools to model the polygonal mesh.

  

 

See Editing Curves Using 
Control Points

See Projecting Curves

See Extracting Curves

See Sculpting Curves

See Embossing

See Pushing / Pulling a Mesh

See Sculpting Surfaces

See Creating Sharp Edges

See Modeling Using a Grid

See Modeling Using an 
Interactive Grid

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/dssugbt0530.htm


Analysis Toolbar
This toolbar contains the following tools to manage the options and graphic properties.

  

 

See Display Options and 
Graphic Properties

See Analyzing Using Highlights

See Analyzing Using Curvature

http://arbre2dsy/spuCXR15/Doc/online/cfyugfss_C2/cfyugfssut0307.htm


Wireframe Toolbar
The Wireframe Toolbar contains the following tools:

See Creating Points

See Creating Lines

See Creating Planes

See Creating Circles

http://arbre2dsy/spuCXR15/Doc/online/cfyug_C2/cfyugcircle3D.htm


Compass Toolbar
This toolbar contains the following tool to manage the compass.

 

See Managing the Compass

http://arbre2dsy/spuCXR15/Doc/online/cfyugfss_C2/cfyugfssut0101.htm


Customizing
Before you start your first working session, you can customize the way you work to suit your 
habits.
This type of customization deals with permanent setting customization: these settings will not 
be lost if you end your session.

1.  Select the Tools -> Options menu item.

The Options dialog box appears. 

2.  Click the Shape category in the left-hand box.

3.  Click the Shape Sculptor workbench

The General tab is displayed.

 
The General tab lets you define the curve sampling option.

 

4.  Set options in these tabs according to your needs. 

5.  Click OK when done.



Shape Sculptor
 

 
This page deals with the general options:

●     Curve Sampling

Curve Sampling

Custom Settings
Check Custom Settings to enable the modification of parameters that control the precision of the 
curves.

 By default, this option is unchecked.

Chordal Deviation
Define the Chordal Deviation by entering a value or using the spinners.

 By default, this option is set to 0.001.

Segment Length
Define the Segment Length by entering a value or using the spinners. 

 By default, this option is set to 0.001.

 



Index 

                   

Numerics
3D Curve  

A
activate 

select  
activate all 

select  
analysis 

highlights  
analyze 

curvature  
analyzing 

using highlights  
associative curve 

creating  

B
Bounding box 

Import  
box trap 

select  
brush 

select  

C
Chordal Deviation 

http://arbre2dsy/spuCXR15/Doc/online/cfyugfss_C2/cfyugfssut0307.htm#ix-analysis::highlights;analyzing::using highlights;command::Highlight;highlight
http://arbre2dsy/spuCXR15/Doc/online/cfyugfss_C2/cfyugfssut0307.htm#ix-analysis::highlights;analyzing::using highlights;command::Highlight;highlight


Decimation  

circle  

bi-tangent and point  

bi-tangent and radius  

center and axis  

center and tangent  

point center and radius  

three points  

tritangent  

two points  

two points and radius  
Cloud Display 

Cloud Display Options  

command  

Graphic properties  

Polyline and Point  

Sampling  

Triangles  
Cloud Display Options 

Cloud Display  
command 

3D Curve  

Activate  

Activate All  

Box Trap  

Brush Select  

Brush Smooth  

Circle  

Cloud Display  

Control Points  

Copy Triangles  

current plane orientation  

Curve Sculpt  

http://arbre2dsy/spuCXR15/Doc/online/cfyug_C2/cfyugcircle3D.htm#ix-command::Circle;circle;creating::circles;creating::circular arcs
http://arbre2dsy/spuCXR15/Doc/online/cfyug_C2/cfyugcircle3D.htm#ix-circle::bi-tangent and point
http://arbre2dsy/spuCXR15/Doc/online/cfyug_C2/cfyugcircle3D.htm#ix-circle::bi-tangent and radius
http://arbre2dsy/spuCXR15/Doc/online/cfyug_C2/cfyugcircle3D.htm#ix-circle::center and axis
http://arbre2dsy/spuCXR15/Doc/online/cfyug_C2/cfyugcircle3D.htm#ix-circle::center and tangent
http://arbre2dsy/spuCXR15/Doc/online/cfyug_C2/cfyugcircle3D.htm#ix-circle::point center and radius
http://arbre2dsy/spuCXR15/Doc/online/cfyug_C2/cfyugcircle3D.htm#ix-circle::three points
http://arbre2dsy/spuCXR15/Doc/online/cfyug_C2/cfyugcircle3D.htm#ix-circle::tritangent
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http://arbre2dsy/spuCXR15/Doc/online/cfyug_C2/cfyugcircle3D.htm#ix-command::Circle;circle;creating::circles;creating::circular arcs
http://arbre2dsy/spuCXR15/Doc/online/cfyugfss_C2/cfyugfssut0101.htm#ix-command:current plane orientation


Curve Select  

Curves Extract  

Decimation  

Delete Triangles  

Display Curvature  

Emboss  

Export  

Extract Triangles  

Flood Select  

Generate Mesh  

Grid Modeling  

Highlight  

Hole Select  

Import  

Interactive Grid Modeling  

Invert Select  

Line  

Mesh Intersect  

Paint Curve  

Plane  

Point  

Project Curve  

Properties  

Push/Pull  

Quick Compass Orientation  

Refine  

Rough Offset  

Sharp Edge  

Slice  

Smooth  

Stitch  

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/dssugbt0530.htm#ix-emboss;command::Emboss
http://arbre2dsy/spuCXR15/Doc/online/cfyugfss_C2/cfyugfssut0307.htm#ix-analysis::highlights;analyzing::using highlights;command::Highlight;highlight
http://arbre2dsy/spuCXR15/Doc/online/cfyugfss_C2/cfyugfssut0101.htm#ix-command::Quick Compass Orientation;quick compass orientation;compass


Tessellate  

compass  

control points  
copy 

triangles  
create 

paint curves  

sharp edges  
creating 

associative curve  

circles  

circular arcs  

line  

plane  

creating point  
current plane orientation 

command  
Current Triangle Count 

Decimation  
curvature 

analyze  
curves 

extract  

project  

sculpt  

select  
Cutting elements 

Trim/Split  

D
decimate 

polymesh  
Decimation 

http://arbre2dsy/spuCXR15/Doc/online/cfyugfss_C2/cfyugfssut0101.htm#ix-command::Quick Compass Orientation;quick compass orientation;compass
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Chordal Deviation  

command  

Current Triangle Count  

Edge Length  

Free Edge Deviation  

Target Percentage  

Target Triangle Count  
delete 

triangles  
Delimitors 

Import  
Direction 

Import  

Rough Offset  

E
Edge Length 

Decimation  

emboss  
Export 

command  

Stl  
extract 

curves  

triangles  

F
Facets 

Import  
flood 

select  
Formats 

http://arbre2dsy/spuCXR15/Doc/online/dssug_C2/dssugbt0530.htm#ix-emboss;command::Emboss


Import  
Free Edge Deviation 

Decimation  
Free edges 

Import  

G
generate 

mesh  
Granularity 

Rough Offset  
Graphic properties 

Cloud Display  
grid 

model  
grid interactive 

model  
Grouped 

Import  

H
highlight  
hole 

select  

I
Import 

Bounding box  

command  

Delimitors  

http://arbre2dsy/spuCXR15/Doc/online/cfyugfss_C2/cfyugfssut0307.htm#ix-analysis::highlights;analyzing::using highlights;command::Highlight;highlight


Direction  

Facets  

Formats  

Free edges  

Grouped  

Minimal point quality  

Statistics  

System  

Update  
intersect 

mesh  
invert 

select  

L
line  

bisecting  

normal to surface  

point-direction  

point-point  

tangent to curve  

up to a curve  

up to a point  

up to a surface  

M
mesh 

generate  

intersect  
Minimal point quality 



Import  
model 

grid  

grid interactive  
modifying 

curves  

O
Offset Distance 

Rough Offset  
option 

U, V Orders  

P
paint curves 

create  
plane 

angle-normal to plane  

equation  

from equation  

mean through points  

normal to curve  

offset from plane  

parallel through point  

tangent to surface  

through planar curve  

through point and line  

through three points  

through two lines  
point 

creating  



Polyline and Point 

Cloud Display  
polymesh 

decimate  
project 

curves  
Projection type 

Trim/Split  
Properties 

command  

pull  

push  

Q
quick compass orientation  

R
refine  
Rough Offset 

command  

Direction  

Granularity  

Offset Distance  

S
Sampling 

Cloud Display  
sculpt 

curves  

surfaces  

http://arbre2dsy/spuCXR15/Doc/online/cfyugrvs_C2/cfyugmeshstrimsplit.htm#ix-Trim/Split:Projection type
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select 

activate  

activate all  

box trap  

brush  

curves  

flood  

hole  

invert  
sharp edges 

create  

slice  

smooth   

using a brush  
Statistics 

Import  

stitch  
Stl 

Export  
surfaces 

sculpt  
System 

Import  

T
Target Percentage 

Decimation  
Target Triangle Count 

Decimation  

tessellate  
Triangles 

Cloud Display  
triangles 



copy  

delete  

extract  
Trim/Split 

Cutting elements  

Projection type  

U
Update 

Import  
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